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SYSTEM OVERVIEW

1. System Overview

The AWOS 3000 is a modular weather monitoring system that continuously measures an array
of weather parameters at an airfield or helipad. The AWOS outputs the data to display terminals
and broadcasts current conditions over VHF radio to pilots in the vicinity.

1.1 General

Figure 1 shows the main AWOS components.

Local Data Output
Operator Interface s
Device & Archiving
Optional Remote Display

| | Outputs

l

Sensor Data Collection Central Data Console
Station Platform Processor KVM Extender (Operator Interface
(DCP) (CDP) Device)

Remote

AWOS Net .
Displays

AWOS Web Web Displays

Figure 1. AWOS Components

A sensor station measures meteorological parameters, which are collected by a Data Collection
Platform (DCP). Data processing, communications, and overall system operation is controlled by
the Central Data Processor (CDP), which also archives and outputs the weather observations.
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Optional remote display interfaces are also possible.

e The KVM Extender can be used for a remote operator terminal to interface to the CDP
using a patch cord between the KVM Extender units.

e AWOS Net can be used to broadcast data via an Ethernet connection to all active remote
displays or via the Internet to allow remote users to view the AWOS data on any
compatible computer using a standard Web browser.

A NADIN connection is possible via a direct connection to the CDP or via a Virtual Private
Network using the AWOS Net and AWOS Web interface.

1.2 Sensor Station

The sensor station measures a full array of meteorological parameters using a configurable suite
of sensors. Available sensors include wind speed, wind direction, barometric pressure, air tem-
perature, dew point temperature, relative humidity, rainfall, cloud height and sky condition,
visibility, present weather, thunderstorm detection, and freezing rain. The standard configura-
tions are listed later in this chapter.

A self-supporting tower is used as the mounting platform for the basic sensor suite. Tilt-over
towers can be provided as required. When included, the ceilometer, visibility sensor, thunder-
storm/lightning detector, and freezing rain sensor are mounted on separate foundations. All
outdoor enclosures meet IP65 (NEMA 4X) specifications.

The AWOS is protected by a comprehensive network of lightning and transient surge protection
components. Tranzorbs, MOVs, and resistors protect all sensor lines, power lines, telephone
lines, and communication lines against lightning-induced surges and power line transients and
surges.

1.3 Data Collection Platform (DCP)

The sensor station is paired with a Data Collection Platform (DCP). Located on the sensor tower,
the DCP collects data from the sensors, performs error detection on the received information,
converts the sensor data into engineering units, and transmits message packets containing sensor
data and status information to the Central Data Processor (CDP) every 5 seconds.

Communications between the DCP and CDP can be accomplished via RS-485 landline or UHF
radio link. The DCP data packets contain a cyclic redundancy check (CRC) that allows the CDP
to determine if any transmission errors have occurred. The CDP ignores data that is not received
correctly.

The dual barometric pressure sensor is housed within the DCP. A keypad and display built into
the DCP allow for on-site viewing of data and sensor maintenance.
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1.3.1 DCP Display Screens

A keypad and LCD display screen are located inside the DCP enclosure, and are used to view
sensor data and to perform maintenance checks. The * and # keys on the keypad are used to
move through the screens. To move to a higher numbered screen, press the # key. To move to a
lower numbered screen, press the * key. The DCP screens are explained in the Model 1190 Data
Collection Platform User's Manual.

1.4 Central Data Processor (CDP)

Data processing, communications, and overall system operation is controlled by the Central Data
Processor (CDP). The CDP is mounted in an industrial-grade rack along with a UPS. The rack
also houses the VHF ground-to-air radio and any of the CDP options, including UHF data link
radio, and AWOS Net. These options are explained in Chapter 2.

1.4.1 Voice Output

A VHF transmitter broadcasts AWOS data in voice format to aircraft in the vicinity. Remote
users can also listen to weather information over a phone line or, using the optional AWOS Net,
access the data over the Internet.

The voice output is generated automatically using collected AWOS data. Custom voice remarks
can be added to the voice output by the operator when conditions warrant (see Chapter 2).

1.4.1.1 VHF Radio

The VHF transmitter operates in the 118—136 MHz band, with the following specifications.

Channel Spacing 25 kHz

RF Power Output 3 W maximum

Frequency Stability +0.001% (-30°C to +60°C)

Emission Type 6KO00A3E (formerly 6A3E)

Spurious and Harmonic Emissions 80 db minimum up to 90% modulation
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1.4.2 Data Reduction

The CDP data reduction software performs quality control checks on the data prior to
meteorological algorithm processing to ensure that the data received is accurate and complete,
and that the associated equipment is working properly. If data from any sensor is erroneous or
missing (e.g. sensor power loss), the parameter and all other parameters derived from the missing
parameter are reported “missing” in the weather observation. The CDP continues to sample data,
and if the error condition is corrected, the weather parameter is restored in the AWOS report.

The CDP sets upper and lower limits on the sensor output corresponding to the normal operating
limits of the sensor.

1.4.3 Data Archiving

The CDP stores collected AWOS data in a series of data logs covering all aspects of AWOS
operation. The logs can be viewed in Archives View (see Section 10.4), and are organized as
follows.

Alarms
Communication Status
DCP Message
METAR

One Minute Data
Printer

System Status

Historical data can also be viewed and saved using the Historical Data option on the File menu
(see Section 8.3).

1.5 Remote Display Options

Two types of optional remote display interfaces are available.

e The KVM Extender can be used for a remote operator terminal to interface to the CDP
using a patch cord between the KVM Extender and the CDP. The KVM Extender con-
sists of a local unit, located near the CDP, and a remote unit, located near the remote
operator interface, and the distance between the local and the remote units can be up to
700 feet. This is useful when the CDP is installed in an equipment room and the actual
operator of the AWOS is located elsewhere, such as in the observation tower.

e AWOS Net can be used to broadcast data via an Ethernet connection to all active remote
displays or via the Internet to allow remote users to view the AWOS data on any
compatible computer using a standard Web browser.
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The KVM Extender uses a proprietary bidirectional communication protocol, while AWOS Net
is restricted to relaying data provided by the CDP.

Voice Output

* VHF radio
f' « Modem
RS-485 proprietary

protocol

Data Collection or UHF Central Data Console
Platform Processor H KVM Extender (Operator Interface
(DCP) (CDP) Device)

RS-232

RS-485

or UHF Remote
Display

AWOS Net

Web Display

Figure 2. CDP Interfaces with DCP and Optional Remote Stations

The remote console (Operator Interface Device) connected to the CDP by the KVM Extender has
complete bidirectional communication capability to interact with the CDP.

Remote displays are display-only stations that use AWOS Net to obtain their data from the CDP.
The AWOS Net consists of an AWOS Net Controller and a communication interface
communicating with the CDP using an RS-232 or an RS-485 landline, or a UHF radio link.

The AWOS Net Controller acquires the data via the CDP communication interface, then
encapsulates it and broadcasts it via Ethernet connection to all active remote connections. This
permits AWOS Net Remote Displays to receive current data within milliseconds of the CDP
broadcasting the update. To ensure the reliability of the data, all communications are validated
for timeliness and correctness before display to the user. The AWOS Net cannot send any
information to the AWOS, and therefore cannot distort or otherwise alter the AWOS data.

The remote displays mirror the data displayed at the CDP following processing and application
of the AWOS algorithms.

1.5.1 Web Displays

Web displays allow remote users to view the AWOS data on any compatible computer using a
standard Web browser.
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1.6 AWOS Configurations

AWOS systems are available in several configurations. The configurations differ primarily in the
sensors included and the communication output mode used (landline or radio).

1.6.1 AWOS |

AWOS | systems provide data for the following parameters.

Wind Speed and Gust

Wind Direction and Variable Wind Direction
Temperature

Relative Humidity

Dew Point

Barometric Pressure

Altimeter Setting

Density Altitude

1.6.2 AWOS Il

AWOS |1 systems add a visibility sensor, rain gauge and day/night detector to the AWOS I array.
The system provides data for the following parameters.

e Wind Speed and Gust

Wind Direction and Variable Wind Direction
Temperature

Relative Humidity

Dew Point

Barometric Pressure

Altimeter Setting

Density Altitude

Visibility and Variable Visibility
Rainfall

Day/Night Detection

1.6.3 AWOS A

AWOS A is a minimal system requiring only a Barometric Pressure sensor. The AWI AWOS A
provides FAA certified data for the following parameter.

e Barometric Pressure

As long as the Altimeter Setting is calculated using the certified Barometric Pressure, the
resulting Altimeter Setting is considered to be certified. This is the calculation that must be used
for the AWOS A to be FAA certified. See Section 1.6.4 for more information.
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1.6.4 AWOS AV

AWOS A-V is a minimal system requiring only Barometric Pressure and Visibility sensors. The
FAA has certified the AWI AWOS 1l as an AWOS A-V. The AWI AWOS A-V provides FAA
certified data for the following parameters.

Barometric Pressure
Visibility and Variable Visibility

The remaining parameters reported by the AWOS A-V are considered to be advisory.

Wind Speed and Gust

Wind Direction and Variable Wind Direction
Temperature

Relative Humidity

Dew Point

Density Altitude

Rainfall

Day/Night Detection

There are two ways to calculate the Altimeter Setting — with and without temperature.

If the calculation uses the advisory Temperature with the certified Barometric Pressure,
the resulting Altimeter Setting is considered to be advisory.

If the calculation uses only the certified Barometric Pressure, the resulting Altimeter
Setting is considered to be certified. This is the calculation that must be used for the
AWOS A-V to be FAA certified.

1.6.5 AWOS Il

AWOS 111 systems add a ceilometer to the AWOS |1 array. The system provides data for the
following parameters.

Wind Speed and Gust

Wind Direction and Variable Wind Direction
Temperature

Relative Humidity

Dew Point

Barometric Pressure

Altimeter Setting

Density Altitude

Visibility and Variable Visibility

Rainfall

Day/Night Detection

Sky Condition and Cloud Height, up to 3 layers
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1.6.6 AWOS III-P

AWOS 3000 USER'S MANUAL

AWOS 111-P systems add a present weather sensor to the AWOS Ill array. The system provides
data for the following parameters.

Wind Speed and Gust

Wind Direction and Variable Wind Direction
Temperature

Relative Humidity

Dew Point

Barometric Pressure

Altimeter Setting

Density Altitude

Visibility and Variable Visibility

Rainfall

Day/Night Detection

Sky Condition and Cloud Height, up to 3 layers

Present Weather (rain, snow, drizzle, mist, fog, freezing fog, haze)

1.6.7 AWOS IlI-T

AWOS I1I-T systems add thunderstorm detection to the AWOS 111 array. The system provides
data for the following parameters.

Wind Speed and Gust

Wind Direction and Variable Wind Direction
Temperature

Relative Humidity

Dew Point

Barometric Pressure

Altimeter Setting

Density Altitude

Visibility and Variable Visibility

Rainfall

Day/Night Detection

Sky Condition and Cloud Height, up to 3 layers
Thunderstorm/Lightning Detection
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1.6.8 AWOS lI-PT

AWOS 111-PT systems add thunderstorm detection to the AWOS 111-P array. The system
provides data for the following parameters.

Wind Speed and Gust

Wind Direction and Variable Wind Direction
Temperature

Relative Humidity

Dew Point

Barometric Pressure

Altimeter Setting

Density Altitude

Visibility and Variable Visibility

Rainfall

Day/Night Detection

Sky Condition and Cloud Height, up to 3 layers
Present Weather (rain, snow, drizzle, mist, fog, freezing fog, haze)
Thunderstorm/Lightning Detection

1.6.9 AWOS lI-PTZ

AWOS I111-PTZ systems add a freezing rain sensor to the AWOS I11-PT array. The system
provides data for the following parameters.

Wind Speed and Gust

Wind Direction and Variable Wind Direction
Temperature

Relative Humidity

Dew Point

Barometric Pressure

Altimeter Setting

Density Altitude

Visibility and Variable Visibility

Rainfall

Day/Night Detection

Sky Condition and Cloud Height, up to 3 layers
Present Weather (rain, snow, drizzle, mist, fog, freezing fog, haze)
Thunderstorm/Lightning Detection

Freezing Rain
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1.7 Sensor Reporting Table

Table 1 shows reporting criteria for each of the AWOS sensors.

The Reporting Units column shows the units in which the sensor data is reported.

The Sliding Window size shows the size of the sliding window used for data averaging.
All sensors, with the exception of precipitation, use a sliding window average. Precipi-
tation reports accumulation from the top of the current hour, and is reset to 0 at the top of
the next hour.

The Time to First Report after CDP Power Up shows the length of time before data
appears on the display following power-up or restart of the CDP.
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Table 1. Sensor Reporting Table

AWOS 3000 USER'S MANUAL

Sensor Reporting Units Sliding i\ZI\(Iaindow Time gl)) I;ir:;“s:fﬁr; after
Wind Speed Knots 2 min 90s
Wind Gust Knots 10 min 90s
(last 10 minutes)
Wind Direction Nearest 10° magnetic 2 min s
Variable Wind Direction | Nearest 10° magnetic 10 min 90s
Temperature °C 5 min 4 min
Dew Point °C 5 min 4 min
Altimeter Setting InHg 1 min 1 min
Density Altitude Feet 5 min 4 min (not reported if <1,000’
above field elevation)
Visibility Statute miles 10 min 8 min
Variable Visibility Statute miles 10 min 8 min
Precipitation 0.01 inches Upto1h <1 min
Sky Condition 100 feet 30 min 28 min
(up to 3 cloud layers)
Clear (SKC/CLR): no clouds below 12,500 feet
Few: 26% to 24% sky cover
Scattered (SCT): 225% to 49% sky cover
Broken (BKN): 250% to 87% sky cover
Overcast (OVC): >87% sky cover
Obscured (VV): cloud bases at surface/fog
Thunderstorm/Lightning | Nautical miles 15 min 1 min

At airport: 0-5 nautical miles

In vicinity: 5-10 nautical miles

Distant: 10-30 nautical miles. In addition to distance, octant directions are

provided for lightning detected in this distance range.

Present Weather

Precipitation type and rate

10 min

8 min

Freezing Rain

Freezing rain

15 min

8 min

11
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1.8 AWOS Output Modes

The output of the AWOS weather observation can be classified into one of four modes of
operation. The mode in effect is dependent on the extent to which voice remarks and manual
observations are used.

1.8.1 Mode 1—Full-Time Automated Operation

In this mode, the AWOS operates 24 hours a day without any manual input. The automated
weather observations are updated on a minute-by-minute basis. There is no weather observer
input to the AWOS. However, a manual observing capability may be maintained as a backup,
provided that an agreement with the National Weather Service (NWS) to maintain a manual
observing capability exists.

1.8.2 Mode 2—Full-Time Automated Operation with Local Notice to Airmen
(NOTAM)

Operation in this mode is the same as Mode 1, with the addition of the capability to append a
manually recorded NOTAM to the automated voice reports. The airport manager is responsible
for the NOTAM information. The NOTAM information is heard on the local voice broadcast; it
is not transmitted longline. There is no weather observer input.

To operate the AWOS in Mode 2, enter a voice remark using the Voice Remarks option on the
Edit menu.

1.8.3 Mode 3—Full-Time Automated Operation with Manual Weather
Augmentation and Local NOTAM Option

Operation in this mode provides the capability for a weather observer to manually augment the
automated observation by appending a weather entry to the observation during the published
weather observer duty hours. The observer duty hours should be published in the Airport/Facility
Directory. The addition of a local NOTAM is also permitted in this mode of operation, provided
there is no interference with the observer augmentation. The weather observer is responsible for
the accuracy and timeliness of the added weather information.

Manual observations are entered using the Manual Observations menu. Any information that
cannot be entered through a manual observation can be appended using the Edit > Voice
Remarks and Reports > METAR Remark menu options.

1.8.4 Mode 4—Part-Time Manual Operation

Operation in this mode, normally used for backup, permits a weather observer to enter a com-
plete manual observation into the system. The procedures in Federal Meteorological Handbook 1
(FMH-1) or Federal Meteorological Handbook 9 (FMH-9) apply to the recording and formatting
of these manual observations.

12
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When operating in Mode 4, all sensors should be turned off using the Turn On/Off Sensors
option on the Edit menu. Manual observations can then be entered using the Manual
Observations menu. Any information that cannot be entered through a manual observation can
be appended using the Edit > Voice Remarks and Reports > METAR Remark menu options.

13
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2. Central Data Processor

The CDP is mounted in an industrial-grade rack (Figure 3), along with an Uninterruptible Power
Source (UPS), VHF ground-to-air radio, voice/RMM modem, and any of the CDP communication
options. The available options include RS-485 data link, UHF radio data link, and AWOS Net.

Density Altitude

‘) dall inc

AWos 3000
Centra) Data p

rocesec
)( 501

Figure 3. AWOS 3000 CDP Rack
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2.1 CDP Rack Layout

The CDP components are housed on two shelves inside the rack’s lockable enclosure. The
shelves can be accessed via the front door or either of the side doors. The easiest entry point will
depend on the component being accessed.

2.2 Back Panel Connections

The back panel (Figure 4) is where connections to external devices and data sources (such as the
AWOS DCP, GPS Receiver, and printer), as well as internal components (such as VHF Radio
and Modem) are made. All connections are surge protected.

The back panel is located inside the CDP rack, just above the bottom shelf (see Figure 7).
External cables are routed to the back panel through an access hole located in the right rear
corner at the top of the rack enclosure. Access to this panel is through the side doors.

oo (wow) ~_ evaomeell e | o o EUOSRED T PN
= =
@ @ ® @ @ @

Figure 4. CDP Back Panel Connectors

Other components and the optional ATIS/AWOS Interface are connected to the Interface Board
(Section 2.3.3).

2.3 CDP Top-Shelf Components

The top shelf (Figure 5) is attached the back of the CDP monitor and contains the CPU assembly,
Power Supply, Interface Board, VVoice Modem, and communication interface (RS-485
converter or UHF radio). The shelf can be accessed by removing four screws from the corners of
the front panel (Figure 6) and sliding the entire shelf, with the monitor, forward.

15
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)= RS-185/UHF

i

Y

VHF RADIO
MOUNTED TO
UNDERSIDE

Figure 5. CDP Top Shelf

Figure 6. Four Screws Securing Top Shelf
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2.3.1 CPU Board
The CPU Board is the CDP’s main processor.

2.3.2 SATADOM

The SATADOM solid state drive is used to store archive data, group and user information, and
the site-specific configuration data. The operating system and AWOS 3000 software are stored
on a read-only partition.

2.3.3 Interface Board

The Interface Board provides interconnections for the CDP components. The individual
connections are shown on wiring diagram 3000-019 in Appendix B.

2.3.4 Power Supply

The Power Supply is a minimum 300 W power supply that provides power to all the CDP
components.

2.3.5 Communications

Communication between the DCP and CDP can be accomplished using RS-485 landline or UHF
radio data link. The method used will depend on several site factors, including the distance
between the DCP and CDP, landline feasibility (trenching issues, cable installation, etc.), and
unobstructed line-of-sight for radio use.

The hardware for the communication options—RS-485 converter or UHF radio—mounts to the
top shelf in front of the CPU Board/Hard Drive assembly.

2.3.6 VHF Ground-to-Air Radio

The Model 1792 or 1793 VHF Ground-to-Air Radio transmits the AWOS voice message to
aircraft in the vicinity. The radio is a low-power VHF/AM transceiver that operates in the
frequency range 118.000 MHz to 136.975 MHz with 25 kHz spacing. The radio is mounted on
the underside of the top shelf of the AWOS rack (see Figure 7), and is installed at the factory.

2.3.7 Voice Modem

An M406159-00 voice modem is mounted to the top shelf below the Interface Board (see Figure 6).
The modem is used for Remote Maintenance Monitoring (RMM) and for dial-up access to the
AWOS voice message. It is installed at the factory.

2.3.8 Monitor Volume Controls

The AWOS voice output can be heard through the monitor’s built-in speakers. To adjust the
speaker volume, use the monitor’s Volume Up (+ or >) and Volume Down (- or <) controls,
located on the monitor bezel below the screen.

17
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2.4 CDP Bottom-Shelf Components

The CDP rack’s bottom shelf (Figure 7) is fixed in place. Components are accessible through the
rack’s front or side doors. The bottom shelf holds the optional AWOS Net and VPN router.

GROUND BAR
~AWOS NET . '
*(optional) BACK PAI\'EL \

oo orive

A
KEYBOARD// |

Figure 7. CDP Bottom Shelf Components

The UPS is housed in the base of the rack, beneath the bottom shelf. The CD drive rests on the
UPS. When not in use, the keyboard is stowed on top of the UPS as well.

The back panel, where cable connections are made to the major components, is mounted to the
back of the rack just above the bottom shelf.

The CDP’s ground cables connect to the ground bar, which is mounted to the rear of the rack
just above the back panel.

2.5 UPS

Continuous power to the CDP equipment is ensured by an Uninterruptible Power Source (UPS)
housed in the base of the rack (Figure 7). If main power is lost, the backup power system will
provide a minimum of 45 minutes of backup power to the CDP equipment.

18
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2.6 GPS Receiver

A GPS receiver (Figure 8) is used to provide time synchronization for the CDP, which displays
UTC and logs events with their UTC time stamp. The receiver, housed in a small, oval package,
is installed outside the CDP. It can often be affixed to the top of the rack, depending on satellite
reception. The GPS receiver presently used is approved only for use at an indoor location.

Figure 8. GPS Time Standard Receiver

2.7 NADIN Connection

If NADIN is used with the AWOS 3000, the NADIN serial cable is routed into the CDP and
connected to the back panel. This is a serial one-way connection used to send METARs.
METARS are sent as they are generated, so changing the METAR frequency (Edit >
Configuration > Reports > METAR) will affect the NADIN interface as well.

2.8 Optional KVM Extender for Remote Operation

The KVM Extender Kit (M488342-00) can be used for a remote operator terminal to interface to
the CDP using a patch cord between the KVM Extender Kit and the CDP. This is necessary
when the CDP is installed in an equipment room and the actual operator of the AWOS is located
elsewhere, such as in the observation tower. The remote location will allow the same access to
the CDP as if the user is physically at the CDP. This location must be within 700 feet of the CDP.

The KVM Extender (M406245-00) consists of the following parts.

1. Local Unit — This unit connects to the CDP. The top unit in Figure 9 is a front view of the
Local Unit.

2. Remote Unit — This unit is located where the operator terminal is desired. The bottom
unit in Figure 9 is a front view of the Remote Unit.

Note that the Local Unit and the Remote Unit are a matched set. If the need arises to
replace either unit, they must be replaced as a set.
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Figure 9. KVM Extender

3. Two grounding cables — One grounding cable for the Local Unit, one grounding cable
for the Remote Unit. The grounding cables are used to connect the ground posts of the
Local Unit and the Remote Unit to their respective devices, the CDP and the remote
operator terminal.

4. KVM cable assembly — This cable connects the Local Unit to the CDP’s monitor and
audio speaker/microphone jacks. The cable assembly includes the USB connection to the
motherboard.

5. Two power supplies — One power supply will power the Local Unit and the other power
supply will power the Remote Unit.

6. Remote Operator Interface — Monitor, keyboard, mouse, speaker, and microphone.

A customer-supplied standard CAT6 Ethernet cable built to standard TIA/EIA-568-B.2-2001
with RJ-45 connectors wired to the T568B scheme is used to connect the Remote Unit to the
Local Unit. Figure 10 shows a wiring diagram for the cable end. This cable may be up to 700
feet long and must be a straight-through cable, not a crossover cable.

1-/IVOUTB
2-VOUTB
3-IVOUTG
4-/VOUTR
5-VOUTR
6-VOUTG
7-/DO
8§-DO

Figure 10. RJ-45 Connectors Wired to T568B Scheme
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Figure 11 illustrates the connection of the KVM extender units using the Ethernet cable.

4 )

Local (consoLe —
KV oD " ® m Ep
Extender
\_ J
CAT6 Ethernet
Cable

¢ A
Remote oo
Kvm O ® B o Ep

Extender

Remote
Operator
Interface

\_ _/

Figure 11. Topology of Local and Remote KVM Extender

The Ethernet cable between the two KVM extender units must not be connected to an Ethernet
network or any other connections. There must be no other connections between the two KVM
extender units.
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2.8.1 KVM Extender Operation

The link light on the front of the Remote Unit should be on to indicate the link is made between
the local and remote units.

For proper operation, the KVM extender should be in AUTO mode. This mode is controlled by
the buttons on both the Remote Unit and Local Unit. On the Local Unit, this button is labels
AUTO/REMOTE and on the Local Unit it is labeled AUTO/LOCAL. Pressing these buttons
will switch between AUTO mode and the mode for that unit. AUTO mode allows both locations
to be used.

LOCAL mode (activated by pressing the button on the Local Unit) locks out the remote user.
The remote location will not be able to access the CDP until the switch is pressed again to return
to AUTO mode.

REMOTE mode is activated by pressing the button on the Remote Unit. This locks out the local
user (at the CDP). The user at the CDP will not be able to access the CDP until the Remote Unit
is placed back into AUTO mode.

There are LEDs near the mode buttons to indicate the operational status of the KVM extender
units. On the Local Unit, there are two LEDs, remote and local. If they are flashing, the KVM
extender is in AUTO mode. If one LED is on with the other off, that unit has control.

There is only one mode LED on the Remote Unit. If this LED is flashing, the KVM extender is
in AUTO mode. If it is on, the Remote Unit has control, and if it is off, the Local Unit has
control.

When the LEDs indicate a unit has control, this may be that there is a user actively using the
CDP and not that the KVM extender is in that particular mode (local or remote).

Only one user can access the CDP at a time. The KVM extender will wait a few seconds once
activity has stopped at one unit (remote or local) before it allows the other unit to access the
CDP.
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2.9 Optional AWOS/ATIS Interface

FCC Title 47 (regulation 87.527¢) only allows one VHF frequency for sites that have both ATIS

AWOS 3000 USER'S MANUAL

and AWOS systems. The AWOS/ATIS Interface connects the VHF and telephone modem

outputs of both of these systems to one VHF transmitter and one telephone modem (Figure 12).
A switch controls the mode of the VHF transmitter and modem. Power (+12 V DC) is supplied

by the CDP. The ATIS/AWOS Interface is installed outside the CDP rack.

2941
Remote
Switch
AWOS
CDP
e e —| 2040/9942
Switching
vrem— INterface
ATIS
System
RMM

VHF Audio f

VHF Keying

Modem Audio

VHF
Transmitter

Telephone
: Modem

Figure 12. AWOS/ATIS Interface Block Diagram
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Two enclosure models are available for the ATIS Interface.

The Model 2940 is a 19" rack-mountable enclosure (see Figure 13). This model fits into
the standard ATIS communication rack or any other standard 19" rack. The 2940 is a one

rack unit (1RU) enclosure. There is no external mode switch on the 2940, therefore a
Remote Switch (Model 2941) is required.

Figure 13. Model 2940 Rack-Mount ATIS Interface

The Model 2942 (Figure 14) is a desktop version of the ATIS Interface. This model has
an LED and mode switch on the front of the enclosure, and so does not require the
Remote Switch. The Remote Switch can still be used with this model, however, if
desired. Important: When the Remote Switch is used with the Model 2942 desktop
interface, the selection switch on the Model 2942 must always be in the ATIS position.

a All Weather Inc. Model: 2942

AWOS @ ATIS

Q!

Ext Switch
From AWOS

From ATIS

I'his Is not Ethernet!

T'his is not Ethernet!

Figure 14. Model 2942 Desktop ATIS Interface
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2.9.1 Remote Switch

The Model 2941 Remote Switch (Figure 15) can be up to 1000 feet away from the ATIS Interface,
and is connected to the interface with a CAT6 patch cord. The Remote Switch has a switch guard
over the switch to prevent accidental switching of the ATIS Interface. The switch guard must be
lifted before the switch can be changed to AWOS mode. When the switch guard is closed, the
switch is automatically switched to ATIS mode. An LED indicator is illuminated when the
switch is in AWOS mode.

Important: When the Remote Switch is used with the Model 2942 desktop interface, the selec-

tion switch on the Model 2942 must always be in the ATIS position (M) —if
the 2942 AWOS/ATIS Interface is left in the AWOS position, the Remote Switch will not be
able to toggle between the AWOS and ATIS options.

When using the ATIS/AWOS switch, also set the VHF Radio to Enable on the Edit > Config-
uration > Voice tab with the AWOS software.

RFACE SWITCAH

AWOS /AT INTER

allweatherine

AT

@
2@

Figure 15. Model 2941 AWOS/ATIS Remote Switch

2.9.2 ATIS Interface Cable

The ATIS Interface Cable (Model M491838-00) is included with both enclosure models, and
enables all the required connections inside the CDP: Power supply, modem audio, and VHF
radio outputs.

2.10 CDP Block Diagram

A block diagram of the CDP components is shown in Figure 16. The colors in the diagram are
used to group certain common components and are intended to make reading easier.
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3. AWOS 3000 Software Views

The AWOS 3000 software displays AWOS data in a combination of text and graphics in three
selectable views, with each view geared toward a specific user group. The current view is
selected by the user via the View menu.

Tower View The Tower View presents a view of weather parameters
of interest to Tower operations, including a graphic
display of wind conditions. See Chapter 5.

Diagnostic View The Diagnostic View is used by maintenance personnel
to maintain and troubleshoot the system. This display
provides a comprehensive view of system and sensor
status. See Chapter 10.

Archives View The Archives View provides access to stored data logs.
See Chapter 10.

A series of menus allows administrators and users to control the data displayed, and enables the
generation and transmission of reports, recording voice remarks, and access to archive data. User
and group access is controlled by restricted Administrator menus, providing for controlled
customization of the data display and software operation. The specific menu availability and the
extent of customizability are controlled by the administrator, and depend on permission settings.
The following chapters explain each of the views and the available menu options in detail.
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4. Alarms

The AWOS 3000 software includes an extensive alarm system to alert the user when specific
conditions of concern are detected. A red Alarm warning will be shown at the top of the display
when alarm conditions exist. When the alarm is “New”—hasn’t yet been acknowledged or
deleted—the color of the warning is bright red. Once the alarm has been acknowledged, the color
will change to a lighter red. If the alarm is deleted, the Alarm warning will disappear. If the
problem has not been corrected before deleting the alarm, however, the alarm will reappear.

There are two types of alarms: warnings and errors. The type of alarm depends on the severity of
the detected condition.

Alarms can be based on several criteria, including

e a certain status bit being repeated several times (for example, a visibility sensor power
supply failure),

e acertain number of occurrences within a time window (for example, CRC errors), and

e acomparison between two values (for example, DCP polls and responses) within a time
window.

Using time windows and repeated occurrences helps eliminate accidental alarms.
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4.1 Alarms List

Clicking the Alarms... option on the System Status menu calls up a list of current and past alarms,
such as that shown in Figure 17. Each alarm entry in the list shows the date and time of the
alarm, its status (New or Acknowledged), the type of alarm, and a brief description of the nature
of the alarm. The time shown for the alarm is the time when the alarm condition was first met.
The time is not updated when the alarm condition is met again.

You can acknowledge or delete active alarms from the Alarms list.

Alarms
 Date | status | Type | Message
19/03/2009 23:25  [New |Errar |DCP - low response rate - check con...

Acknowledge Delete L Close

Figure 17. Alarms List

4.1.1 Acknowledging and Deleting Alarms

When an alarm is triggered, it will remain active (its status will show New) until either acknow-
ledged or deleted by the user. No further entries for an active alarm will be added to the alarm
list until it is acknowledged or deleted.

To acknowledge an alarm, click the alarm on the list to highlight it, then click the
Acknowledge button at the bottom of the screen.

e "Ack" will be displayed in the Status column on the Alarms list

e The color of the Alarm text will change to a lighter red once all alarms have been
acknowledged or deleted. The Alarm warning will continue to be displayed after
the alarm is acknowledged (in the lighter color) even when alarm conditions no
longer exist in order to keep an operator alert to intermittent problems.

To delete an alarm, click the alarm on the list to highlight it, then click the Delete button at
the bottom of the screen.

e All visual warnings will stop and the Alarm notice on the main display will be
removed
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e The alarm will be deleted from the Alarms list; a record of the alarm will still be
maintained in the Alarms Log

e If the conditions that triggered the alarm are not addressed before the alarm is
deleted, the alarm will reappear

Click Close to close the Alarms list.

4.2 Blink Alarm

The Blink Alarm option controls the alarm's visual appearance on the display. If the box is
checked, the Alarm notice on the main display will blink when active. If the box is unchecked,
the Alarm notice on the main display will remain steadily on. Regardless of the setting, all
alarms will appear on the Alarms list explained above.
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5. Tower View

The Tower View is shown in Figure 18. This is the default view and does not require login. The
screen is divided into sections, with each section showing a group of related values. Only sensors
installed on a given system will be shown on the display. When an alarm is present, an Alarm
notice will appear at the top of the display (refer to Chapter 4 for details on alarm behavior).

File Edit View Manual Observations Reports System Status Help

24/04/2009

Remark

7z
//>
Gust Variable Winds

12

2

LTG DSNT W
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5.1 Special Characters

AWOS 3000 USER'S MANUAL

Several special characters are used in the AWOS 3000 display and in data logs to indicate when
data are missing, when sensors are offline or not installed, and when data have been entered

manually.

Condition Display Reports
Missing Data I I
Sensor Turned Off blank #
Sensor Not Installed field removed * *
Data Entered Manually blue text <>

The Present Weather field will be displayed whenever a visibility sensor is installed, even if no
Present Weather sensor is installed

Figure 19 is a sample data log showing special characters in use. In the first entry, a number of
fields show missing data, as indicated by slashes (Wind Speed, Wind Direction, etc.). Farther
down in the file, Density Altitude and Altimeter Setting are shown as being turned off,
indicated by ####. Finally, manual observations for Sky Condition are shown near the bottom
of the file (<FEW040 BKNO75

B OneMinute 20091118.log - Notepad

Fle Edt Format View Help
AWOS3000 One Minute Repor
Report Started on 18/11/2009 for wax
APIQ DDHHMM WS
KAWI 180000 /// /// /// /////// /////
KAWI 180001 VA
KAWI 180002 0 /7//
KAWI 180003 11777
KAWL 180004 A
KAWI 180005 VI
KAWI 180006 Vil
KAWI 180007 1172
11/2
11/2
1172
KAWI 180011 11/2
KAWI 180012 11/2
KAWI 180013 s B 17
11/2
11/2
11/2
KAWI 180017 0 340 11/2
KAWI 180018 0 340 11/2
KAWI 180019 0 340 11/2
KAWI 180020 0 340 11/2
KAWI 180021 0 340 1472
KAWI 180022 0 340 11/2
KAWI 180023 0 340 1172
KAWI 180024 0 340 11/2

VARVIS
VLI
////;;;/;//
7
//////////
VIL s

DDUDOUUDDDDDDDDDDDDDDDDDDD0

PW

>).

DP
////////// A A

LI

7

5
L /A
I e s
e
I e

s

// i //// i 3
/) //////// A
T e s
1 s
5

5

5

5

5

5

5

5

5

5

LI, 1

I,

VI
/17 /////////////////7//// 16
Vi A
LTI AL AIL 117170 16

<FEW040 BKNO75
<FEW040 BKNO75
<FEW040 BKNO7S
<FEW040 BKNO75

vVvVvv
[
o

/7
(11, //////7 AR

LT RAIN
2994 0

994 0
2994 0
2994 o
2994 ]
2994 0
2994 0
#id [}
Piiad 0
#did 0
#FdE [}
FdE o
#id [}
FEE 0
#i 0
Fhd [}
#ig 0
F [}
Fi 0
Piiad 0
FE 0
#idE 0
Fd# [}
#i 0
FEE 0

Figure 19. Log File Showing Special Characters
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5.2 Winds

Wind speed and wind direction (Figure 20) are two-minute running averages calculated from
sensor readings taken at one-second intervals. Wind direction is in degrees relative to magnetic
North, wind speed values are in knots.

e The current wind direction is shown on a graphic dial that also shows the two-minute and
ten-minute wind direction ranges along its rim.

e Wind direction is also shown numerically in the upper text box within the dial.
e Wind speed is shown in the lower text box within the dial.

e Wind gust and variable winds, when present, are shown below the dial.
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Figure 20. Winds Display
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5.2.1 Wind Speed

The most recent wind speed value is shown in the lower text box within each dial, with values
ranging from 0 knots to 120 knots. Wind speed is a two-minute average calculated by the CDP,
updated every 5 seconds. When speed is less than three knots, the system indicates calm wind
conditions.

5.2.2 Wind Direction

The most recent wind direction value is shown on a graphic 360° dial, and is displayed in the
upper text box within the dial. Wind direction is a two-minute average calculated by the CDP,
updated every 5 seconds. It is reported in degrees.

5.2.3 Wind Direction Range

The outer rim of the wind dial shows the two-minute and ten-minute wind direction range. The
two-minute range is shown in yellow bars, and the ten-minute range is shown as a solid green
band. The range increases or decreases in steps of 10°, with the outermost edges showing the
wind direction extremes for the averaging period.

5.2.4 Wind Gust

Wind gusts are reported when the difference between the maximum and minimum wind speeds
measured over the past 10 minutes is 10 knots or greater. The wind gust value, when present, is
shown in a text box below the wind dial.

5.2.5 Variable Wind Direction

Variable Wind Direction, when present, is shown in a text box below the wind dial.

e Variable wind is reported when the wind direction varies around the two-minute average
wind direction by 60 degrees or more, and the wind speed is more than 6 knots.

The displayed value shows the upper and lower ends of the direction variation, separated by a
"V". As an example, a displayed value of 040V130 would mean the direction is varying
between 40° and 130°.

The display will show simply VRB if:
e Wind speed is more than 6 knots and the direction is varying by more than 180°.

or

e Wind speed is 3—6 knots and the direction is varying by 60 degrees or more.
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5.3 Visibility

Visibility (Figure 21) is a ten-minute average calculated each minute from sensor readings taken
at ten-second intervals. It is reported in statute miles.

24/04/2009
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Figure 21. Visibility Display

35



TOWER VIEW AWOS 3000 USER'S MANUAL

5.4 Present Weather

The Present Weather field (Figure 22) shows the calculated present weather value. Present
weather is derived from data for several parameters, including air temperature, dew point
temperature, visibility, lightning (when available), and precipitation type and rate data from the
present weather sensor.

Present weather data in this window is averaged over a ten-minute period by the present weather
sensor and updated every 5 seconds. Present weather is reported in codes. Table 2 lists the codes
reportable by the AWOS.
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Figure 22. Present Weather Display
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Table 2. Present Weather Codes

Guide to Present Weather Abbreviations

Intensity Descriptor Phenomena
- light BC* patches BR mist IC* ice crystals
(blank) moderate BL* blowing DS* dust storm PL* ice pellets
+ heawy | DR* | lowdriting | Dyt | “MAeSPreaddust | pg. | weldoveloped
\'[ in vicinity FzZ freezing Dz drizzle RA rain
funnel cloud,
MI* shallow FC* tornado, SA* sand
waterspout
PR* partial FG fog SG* show grains
SH* showers FU* smoke SN snow
TS thunderstorm GR hail SQ* squalls
GS* small hail/snow ss* sand storm
pellets
HZ haze VA* volcanic ash

* These conditions are not automatically reported, and will only appear if entered as a manual observation.

Adapted from FMH-1 and FAA Order 7900.5B.
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5.5 Sky Condition

The system reports sky condition (Figure 23) based on cloud cover measurements taken by the
laser ceilometer. When clouds are present, the Sky Condition field shows a cloud cover
description followed by the height of the cloud base. The type of cloud cover is represented by
the following codes.

e CLR/SKC—sky clear (no clouds below 12,500 feet); CLR is displayed when the data are
generated automatically from the ceilometer, SKC is displayed when the observation is
entered manually via the Manual Observation > Clouds menu

o FEW—few (>6% to 24% sky cover)

o SCT—scattered (>25% to 49% sky cover)
e BKN-—broken (>50% to 87% sky cover)

e OVC—overcast (>87% sky cover)

e VV—obscured (cloud bases at surface/fog)

Cloud height is shown in hundreds of feet (12,000 feet, for example, is represented by “1207).
Sky condition is estimated based on conditions directly above the ceilometer over a 30-minute
sliding window.
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Figure 23. Sky Condition Display
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5.6 Temperature

The Temperature section displays the most recent reportable values for Air Temperature, Dew
Point, and Relative Humidity (Figure 24).

5.6.1 Air Temperature

Air Temperature is a five-minute average calculated by the CDP from readings taken by the
Temperature/Relative Humidity sensor at one-second intervals. It is reported in °C and is
updated every 5 seconds. The reportable range is -40 to +60°C.

5.6.2 Dew Point

Dew Point temperature is a five-minute average calculated by the CDP from temperature and RH
sensor readings taken at one-second intervals. It is reported in °C and is updated every 5
seconds. The reportable range is -40 to +60°C.

5.6.3 Relative Humidity

Relative Humidity is a two-minute average calculated by the CDP from RH sensor readings
taken at one-second intervals. It is reported in percent (0-100), and is updated every 5 seconds.
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Figure 24. Temperature Display
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5.7 Air Pressure

The Air Pressure section (Figure 25) displays the most recent reportable values for Altimeter
Setting and, if applicable, Density Altitude. These values are updated every 5 seconds.

5.7.1 Altimeter Setting

Altimeter Setting is the pressure value to which the altimeter of an aircraft on the ground is set so
that it will indicate the MSL (mean sea level) elevation of the airport. The two pressure sensors
in the AWOS must agree to within 0.04 inHg and the temperature inside the sensor housing must
be >-40°C and <60°C for altimeter setting to be reported. Units are inHg.

5.7.2 Density Altitude

Density Altitude is the altitude in the standard atmosphere where air density is equivalent to that
of the airport. This is used by pilots to determine aircraft performance. Density altitude is not
reported if it is less than 1000’ above the field elevation.
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Figure 25. Air Pressure Display
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5.8 Precipitation

The Precipitation section (Figure 26) shows the amount of precipitation measured during the past
hour, counting from the beginning of the hour. (A measurement reported at 2:15, for example,
would show the amount of precipitation measured over the past 15 minutes.) Precipitation is
reported in inches and updated every 5 seconds. The precipitation value is reset to 0 at the top of
every hour.

(User: Admin)
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Figure 26. Precipitation Display
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5.9 Variable Visibility

AWOS 3000 USER'S MANUAL

Variable Visibility (Figure 27) is determined based on an algorithm that analyzes the one-minute
average visibility values. Each one-minute average is compared to the previous one-minute
average, and if the difference is greater than 0.5 miles, a positive or negative change is logged.
The algorithm then evaluates the past ten minutes worth of this logged data, noting each recorded
change. If three or more changes have been logged over the ten minute period, along with two or
more sign changes, variable visibility is reported. Otherwise, the field is left blank.
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5.10 Lightning

When a Model 6500 Thunderstorm Detector is installed, lightning data is displayed on a graphic
dial (Figure 28) and in text form below the dial.
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Figure 28. Lightning Display

The Lightning dial is divided into octants, which indicate the direction of the lightning, and into
two concentric areas (center circle and secondary ring) that indicate distance from the airport.

e [f strikes are detected within 0—5 nautical miles, the center circle on the dial will be illu-
minated. The text display will show "TS at Airport". This will be voiced in the AWOS
voice message as "Thunderstorm at the airport".

e Ifstrikes are within 5—10 nautical miles, the secondary ring on the dial will be
illuminated. The text display will show “Thunderstorm in Vicinity”. This will be voiced
in the AWOS voice message as "Thunderstorm in the vicinity".

e If strikes are detected within 10-30 nautical miles, one or more direction octants will be
illuminated showing the direction in which lightning has been detected. The text display
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will show “LTG DSNT” followed by the direction abbreviation. The AWOS voice
message will report “Lightning” followed by the direction.

o If strikes are reported in 4 or more non-contiguous quadrants, the display will show
“ALQDS”. This will be voiced in the AWOS voice message as “Lightning all quadrants”.

e Ifno strikes are detected, no part of the dial will be illuminated. The text display will be
blank, and no lightning data will be included in the AWOS voice message.

CENTER SECONDARY
CIRCLE RING
(0-5 NM) (5-10 NM)

OCTANTS
(10-30 NM)

Figure 29. Lightning Dial
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5.11 Remark

The Remark panel (Figure 30) shows any active weather remarks entered by an operator.
Weather remarks are entered using the Reports > METAR Remark menu option.
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6. Navigating the Menus

The menu categories on the menu bar at the top of the display each present a drop-down menu
when clicked. Where keyboard shortcuts are available, they are noted in the text. The functions
accessible from each of the menus is discussed in detail in the following chapters.
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7. Restricted Functions

Certain menu functions are available only to technicians equipped with the AWOS Security Key
CD. These functions are all found on the Edit menu, and are described below.

7.1 Edit Menu

7.1.1 Configuration > Airport > General Tab

The Airport tab (Figure 31) contains two sub-tabs: General and Runways. The Runways tab is
available to all users. The General tab contains a number of options unique to the airport

location.

Configuration

X

[Rirport_| Reports | Sensors | Voice | Misc |
" General | Runways |

Airport Name: AW0S 3000 |

ICAO Identifier

Elevation (MSL):

BP Sensor Elevation (MSL):

BP 1 Offset: inHg

BP 2 Offset: inHg

Ceilometer Elevation (AGL):

Magnetic Declination: (®) East ) West
} OK 1 ’ Cancel |

Figure 31. Configuration General Tab
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Table 3 provides further detail on the parameters displayed on the “General” tab.

Table 3. Parameters on the General Tab

General
. The name entered here will be shown at the top of the display. Affects
Airport Name . o .
the displayed name only; voice output is not affected.
ICAQ Identifier The four-letter ICAQ airport identifier or three-digit airport identifier
Elevation (MSL) The elevation of the airport above mean sea level

BP Sensor Elevation (MSL) | The MSL elevation of the barometric pressure sensor

The offset value for barometric pressure sensor 1; this is a sensor-
specific constant that varies from sensor to sensor

The offset value for barometric pressure sensor 2; this is a sensor-
specific constant that varies from sensor to sensor

When the ceilometer is not located at the runway or pad, the difference
in elevation between the ceilometer location and the landing surface is
entered here. If the ceilometer is installed at a location higher in
elevation than the landing surface, the value entered is positive; if the
ceilometer is installed at a location lower in elevation than the landing
surface, the value entered is negative.

The magnetic declination of the airport; used to convert between True
North and Magnetic North values

BP 1 Offset

BP 2 Offset

Ceilometer Elevation (AGL)

Magnetic Declination

7.1.1.1 Barometric Pressure Offsets

If the Model 7150 or Model 7190 Dual Digital Barometer sensor unit is replaced, it will be
necessary to update the BP 1 and BP 2 offsets shown in Figure 31 and described in Table 3.

A keypad and LCD display screen are located inside the DCP enclosure, and are used to view
sensor data and perform maintenance checks. Use the * and # keys on the keypad to move
through the screens—press the # key to move to a higher numbered screen, or press the * key to
move to a lower numbered screen. Screen 8 shows the readings for the two pressure sensors
using inHg units. A value of 99.999 indicates missing data.

The barometric pressure is measured using a Setra Systems Model 370 Ultra-High Accuracy
Setraceram™ pressure standard. Note the difference in readings for each Model 7150 or Model
7190 sensor displayed on the DCP screen from the pressure standard reading using inHg units. If
the readings differ by more than 0.05 inHg, replace the sensor. Otherwise, access the Airport >
General tab, enter the two offsets, and click OK to save them. An offset will be “negative” if the
sensor reading is greater than the reference pressure standard.
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7.1.2 Configuration > Sensors Tab

Use the Sensors tab (Figure 32) to specify the type of AWOS installed and the sensors used. The
specific type of sensor for a given parameter need not be specified (for example ultrasonic wind
vs. cup and vane); the AWOS software determines this internally.

The selection made here determines what data modules appear on the display. If a sensor is
unchecked on this list, it will not appear on the display, will not be mentioned in the voice
output, and will be shown as not installed (indicated by “*”’) in data logs.

Table 4 provides further definition of the fields found on the Sensors tab.

Configuration @

=

i'vAirpon [ Reports || Sensors Voice | Misc }

AWOS Type
Sensors Installed

[v] Barometric Pressur
Cloud Height Indicator

v 8329 (® 8339

[V] Freezing Rain

7] Precij n {Intensi
[¥] Tipping Bucket Rain Gauge
Visibility

[V ® 8364 (6498

[¥] Wind Speed / Direction

Lightning

v @ Local ) AD,

‘ OK H Cancel ‘

Figure 32. Sensors Configuration Tab

Table 4. Sensors Tab Fields

Sensors

Select the type of AWOS installed from the dropdown list. Selecting a specific
AWOS Type type will automatically check and uncheck the sensors associated with that type.
If your system varies from one of the pre-defined AWOS types, select CUSTOM
from the list and select the installed sensors manually.
Sensors are automatically selected in this panel when an AWOS Type is
Sensors Installed | selected above. If a custom system is used, select CUSTOM for AWOS Type
and select the installed sensors manually from this list.
Check the Lightning option to add the lightning dial and text display to the
Tower View. Select Local to display the data from the AWOS Thunderstorm/
Lightning sensor, or select ADAS to display data are from the ADAS network.
Only the Local option is supported at this time.

Lightning
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7.1.3 Alarm Configuration Menu
(Keyboard shortcut Alt+e then a)

Sensor alarms can be set to alert the operator when a sensor is reporting values that are out of
range (“Range Alarms”) or that have remained unchanged for an extended period (“Static

Alarms”).
The Alarm Configuration menu (Figure 33) contains tabs for each sensor for which alarms can
be set. Each tab contains a set of fields (identical for each tab) that are separated into Range and
Static panels.
e The Range panel contains the minimum and maximum values that the sensor is able to
report. These values are sensor-specific. If either of these values is exceeded, an alarm is
triggered and the data are reported as missing (invalid).

e The fields within the Static panel are used to set the range, number of samples, and time
period over which values are considered in determining whether a sensor’s output is
“static” (unchanged over an extended period) or the data are missing (invalid).

Alarm Configuration @

(Vasibility | Wind Direction | Wind Speed |
i Barometric Pressure | Air Temperature | Dew Point \

Range

e [
Minimum: | 0
Maximum: \ 20|

Static

Enabled: ™

Minimum: 717
Maximum: ;2,
Minimum Samples: o j
Evaluation Time Period: E@E [01%

Sensitivity: 1 () Mild ) Normal () Aggressive

{ OK ‘ ’ Cancel |

Figure 33. Alarm Configuration Screen

Note that the minimum shown for the Static panel on the sample screen in Figure 33 is
“-1” and the maximum shown is “-2”. This is intentional to make sure that static input

checking is not used by default in case the Enabled box is checked.

The sensitivity entry does not affect calculations, but only influences whether an alarm is
generated.

The next section discusses the Alarm Configuration menu settings.
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7.1.3.1 Setting Range Alarm Values

Click the appropriate tab at the top of the screen to select a sensor.

Enter the minimum value the sensor is capable of reporting in the minimum field within
the Range panel. (Refer to the sensor specifications for this value.)

Example: For a Model 2040 Ultrasonic Wind Sensor, you would enter a
minimum value of 0 on the Wind Speed tab, since 0 knots is the minimum
value the sensor is capable of reporting.

Enter the maximum value the sensor is capable of reporting in the maximum field within
the Range panel. (Refer to the sensor specifications for this value.)

Example: For a Model 2040 Ultrasonic Wind Sensor, you would enter a
maximum value of 130, sincel130 knots is the specified top end of the
sensor’s reporting range.

7.1.3.2 Setting Static Alarm Values

Static Alarms are determined by calculating the standard deviation for a set of data values. The fields
in the Static panel are used to specify the data set, including the range of values to be considered, the
minimum number of samples required, and the time period covered. An alarm is triggered if the
standard deviation for the specified data set is less than or equal to the sensitivity setting.

1.

7.

Click the Enabled checkbox to enable static alarms for the sensor. To disable static
alarms, click the Enabled checkbox again.

Enter the lowest reported value to be considered in the data set in the minimum field.

Example: For wind speed, a reasonable value would be 1. This would remove
a value of 0 from consideration, which is commonly reported for long periods
under calm conditions.

Enter the highest value to be considered in the data set in the maximum field.

Example: For temperature, a reasonable value would be +60° C, the
specified maximum reportable temperature for the sensor.

Enter the minimum number of samples required for a data set.

Enter the evaluation time period in hours and minutes. This is a moving window that
includes the most recent group of values recorded over the specified period of time. As a
new value i1s added to the data set, the oldest value (now falling outside the time period)
is discarded.

Select a Sensitivity setting of Mild, Normal, or Aggressive (a more aggressive setting
will cause more alarms to be triggered). Each of these settings corresponds to a numeric
value that is automatically entered into the Sensitivity text box when a setting is selected.
You can also enter a custom value in the text box.

Repeat these steps for each sensor tab.

When done, click OK to save the settings, or click Cancel to discard any changes made and
close the Alarm Configuration window.
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7.1.4 Configuration > Voice Tab

The options in the Test panel at the bottom of the Voice tab are used by technicians to test the
AWOS voice output.

Configuration E|
Airport | Reports | Sensors | Voice Misc
Status Playback
‘@ Commissioned ® Automatic
! Test Mode ) Manual
Phone VHF Radio
(@ Enable @ Enable
i Disable i Disable
Phone Remark Test
) Word
' Enabled ) 300 Hz Tone
() Disabled ) Modulated 300 Hz Tone
) Inactive

Figure 34. Voice Configuration Tab

e The Word option broadcasts words from the AWOS voice dictionary. This option is used
in testing by AWI technicians.

e The 300 kHz Tone and Modulated 300 kHz Tone options transmit successive 30-second
300 kHz tones, with short pauses between the tones. This option is used to set the
modulation for the voice output.

e The Inactive option turns off the test output. This is the setting used during normal
operation.
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7.1.5 Voice Remark

The Voice Remark option described in Section 9.8 lets users to record up to two 90-second voice
remarks to be appended to the outgoing AWOS voice message.

Note: VHF radio and telephone voice outputs are suspended while the Voice Remark window is
open.

The administrator also has access to the Admin Remark tab shown in Figure 35, which you click on
to record an administrative remark such as the airport name to be used at the beginning of the voice

message.
Yoice Remark @|

Playback
® Automatic
) Manual

Admin Remark
Remark One r Remark Two |

Enabled: ' On ® Off
Persistent: ' On ® Off

‘ OK H Cancel ‘

Figure 35. Administrator Voice Remark Screen

7.1.5.1 Recording the Airport Name

Note that you must be logged in as the administrator or as a user with Configuration privileges
(configured by the administrator via Edit > Group Authorizations) to access the Airport tab to
record the airport name to be used at the beginning of the voice message.

To record the airport name to be used in the outgoing voice message:
1. Click the Airport tab.
2. Click the record button | @ to begin recording.
3. Speak the airport name clearly into the workstation or CDP microphone.
4. When done, click the stop button | ®

Click OK to save the recording, or click Cancel to exit the Voice Remark screen without saving
the recording.

The Enabled and Persistent options are the same as those described in Section 9.8 for other
users.
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8. File Menu
(Keyboard shortcut Alt + f)

The File menu (Figure 36) contains options for logging in and out, retrieving historical data,
printing, and window control.

Login ...

Logout

Historical Data ...

Printer Setup ...

Minimize
Exit

Figure 36. File Menu

8.1 Login
(Keyboard shortcut Alt+f then i)

The Login option is used to log in to the system as a User. Each User has access to specific
screens and functions, as set by the administrator through the User Authorizations and Group
Authorizations options on the Edit menu. The use of these options is explained in detail in the
next chapter.

e To login, select a User from the pull-down menu.
e Enter your password in the Password field, then click OK.

e The User name under which you are logged in will be shown in parentheses at the top of
the screen, and all applicable menu options will now be available.

8.2 Logout
(Keyboard shortcut Alt+f then o)

To log out of the current group, click Logout. All menu options requiring login will be grayed out.
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8.3 Historical Data
(Keyboard shortcut Alt+f then h)

The Historical Data option lets you call up a range of archived data for viewing or saving to a
CD. Once saved, the data can be imported into a spreadsheet on another PC as a comma-
delimited text file, which allows the data to be graphed and analyzed. Data importing and
analysis cannot be performed on the AWOS CDP.

The data type and date range to retrieve are specified using the Historical Data Selection screen
shown in Figure 37.

Historical Data Selection @

Select the data elements for reporting
Unselected: Selected:
Air Temperature [
Air Temperature 10 Minute
Air Temperature 5 Minute = |\ Add >3
Altimeter Setting
BP
Cloud Layer
Day/Might
Density Altitude << Remove All
Dew Point L
Dew Point 10 Minute At

C

— Add All >>

4

® View Data ( Save Data

Start: Date 19/03/2009 /(3| Hour | 21}
End: Date 19!0312009@%1" 21

@ 1Minute ) 15 Minute ) 30 Minute ) 1 Hour

‘ OK H Cancel i

Figure 37. Historical Data Selection Screen

The following steps describe how to retrieve a range of data.

1. Select the data type from the left Unselected panel, then click Add>> to add it to the
Selected panel on the right.

e To select multiple data types from the list, hold down the Ctrl key while clicking.

e To select a group of data types adjacent to one another on the list, click the first data
type, then hold down the Shift key while clicking the last data type.

e To add all the data types on the list, click Add All>>.
2. Choose whether you want to view the data or save it to a file.

e Select View Data to have the selected data brought up in a display window (Figure
38) once selection is complete.

e Select Save Data to save the selected data to a CD once selection is complete.

55



FILE MENU AWOS 3000 USER'S MANUAL

Historical Data

X

Date and Time ALS Air Tmp 10 .| Air Tmp 10 ... |Air Tmp 2 MinjAir Tmp 2 MinjAir Tmp 24 Hiair Tmp 24 HyAir Tmp 60 .| Air Tmp 60 .| Air
03/11/2009 21:00:00 (00010 15.56 15.56 15.56 15.56 15.56 15.56 15.56 15.56 [a]
03/11/2009 21:01:00 |00010 15.56 15.56 15.56 15.56 15.56 15.56 15.56 15.56 =
03/11/2009 21:02:00 (00010 15.56 15.56 15.56 15.56 15.56 15.56 15.56 15.56
03/11/2009 21:03:00 (00010 15.56 15.56 15.56 15.56 15.56 16.56 15.56 15.56
03/11/2009 21:04:00 [00010 15.56 15.56 15.56 15.56 15.56 16.56 16.56 15.56
03/11/2008 21:05:00 (00010 15.56 15.56 15.56 15.56 15.56 16.56 15.56 15.56
03/11/2008 21:06:00 |00010 15.56] 15.56! 15.56! 15.56 15.56 15.56 15.56 15.56
03/11/2008 21:07:00 |00010 15.56] 15.56; 15.56! 15.56 15.56 15.56 15.56 15.56!
03/11/2009 21:08:00 (00010 15.56 15.56 15.56 15.56 15.56 15.56 15.56 15.56
03/11/2009 21:09:00 (00010 15.56 15.56 15.56 15.56 15.56 15.56 15.56 15.56
03/1142009 21:10:00 [00010 15.56 15.56 15.56 15.56 15.56 15.56 15.56 15.56
03/11/2009 21:11:00 (00010 15.56 15.56 15.56 15.56 15.56 15.56 15.56 15.56
03/11/2009 21:12:00 [00010 15.56 15.56 15.56 15.56 15.56 16.56 15.56 15.56
03/11/2009 21:13:00 [00010 15.56 15.56 15.56 15.56 15.56 16.56 15.56 15.56
03/11/2009 21:14:00 |00010 15.56 15.56 15.56 15.56 15.56 16.56 16.56 15.56
03/11/2008 21:15:00 00010 15.56 15.56 15.56 15.56 15.56 15.56 15.56 15.56
03/11/2008 21:16:00 |00010 15.56] 15.56; 15.56! 15.56 15.56 15.56 15.56 15.56
03/11/2009 21:17:00 |00010 15.56] 15.56! 15.56! 15.56 15.56 15.56 15.56 15.56
03/11/2009 21:18:00 (00010 15.56 15.56 15.56 15.56 15.56 15.56 15.56 15.56
03/11/2009 21:19:00 (00010 15.56 15.56 15.56 15.56 15.56 15.56 15.56 15.56
03/11/2009 21:20:00 {00010 15.56 15.56 15.56 15.56 15.56 15.56 15.56 15.56
03/11/2009 21:21:00 [00010 15.56 15.56 15.56 15.56 15.56 15.56 15.56 15.56
03/11/2009 21:22:00 |00010 15.56 15.56 15.56 15.56 15.56 16.56 15.56 15.56
03/11/2009 21:23:00 (00010 15.56 15.56 15.56 15.56 15.56 16.56 15.56 15.56
03/11/2009 21:24:00 (00010 15.56 15.56 15.56 15.56 15.56 15.56 15.56 15.56 A
[« i [ | »]

Figure 38. View Historical Data Example

3. Set the range for the data to be retrieved by entering the date and time of the first file to
retrieve in the Start window and the date and time of the last file in the End window. To
change the date, click the calendar icon to call up a monthly calendar, then click the ap-
propriate date. To change the time, click within the Hour field then click the up or down
arrow to change the value.

4. Select the sampling interval: 1 Minute, 15 Minute, 30 Minute, or 1 Hour. This
determines the frequency of data points within the selected date and time range. If you
select 15 Minute, for instance, data values will be retrieved at 15-minute intervals.

5. Click OK to retrieve the data. Or click Cancel to close the Historical Data Selection
screen without retrieving any data.

The CD drive is just below the monitor in the CDP rack enclosure.

Only data representing a small number of days can fit on one CD if all the sensors are selected,
but considerably more data can be stored from just one sensor. The CDP will show an error
message if you attempt to store more than a CD can handle, and so you can iteratively reduce the
amount of data by selecting fewer logs, a shorter time length, or a reduced reporting frequency if
you get the error message.
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8.4 Printer Setup
(Keyboard shortcut Alt+f then s)

The Printer Setup option lets you set up the printer for automatic printing, check printer status,
send a test page, and send a “TOP OF FORM” command. Figure 39 shows the Printer Setup
dialog. The default print setting is Automatic Printing, 1 Minute Frequency.

Printer Setup @

Automatic Printing

on: [v]

R R

Frequency: ‘1Minu’(e v

Printer Status
Status: OK Reset J

' Print Test Page ’ 1 Set Top of Form ;

’ OK ‘ ‘ Cancel l

Figure 39. Printer Setup Dialog

8.4.1 Automatic Printing

AWOS data can be sent to the printer automatically at a specified interval using the Automatic
Printing option.
e Select the On checkbox to turn automatic printing on.

e Click the checkbox again to toggle the setting off.
Any time the printer is disconnected, the data will continue to buffer when Automatic Printing is
turned on. When the printer is reconnected, the data in the buffer will start to print. If there is no

need to print out the buffered data when the printer is reconnected, remember to uncheck the
checkbox to disable automatic printing before disconnecting the printer.

8.4.2 Printer Status

The Printer Status field shows the current status of a connected printer. This should normally
read OK. If the status reads Error, follow the steps below.

1. Check the printer and fix any problems (jammed paper, etc.).

2. Click the Reset button to reset the status to OK.

3. At the printer, position the paper correctly, then click Set Top of Form.

57



FILE MENU AWOS 3000 USER'S MANUAL

8.4.3 Print Test Page

Click Print Test Page to send test pages to the printer to check that the printer is operating
properly.

8.4.4 Set Top of Form

Click the Set Top of Form button to tell the software that the paper is positioned correctly and is
ready for printing. This should be performed whenever paper is changed, repositioned, or
following the clearing of an error.

8.5 Minimize
(Keyboard shortcut Alt+f then m)

Click the Minimize option to minimize the display. The software will continue running when
minimized. To restore the display to full screen, click the AWI AWOS icon on the application
toolbar at the bottom of the screen.

8.6 Exit
(Keyboard shortcut Alt+f then x)

Click the EXxit option to close the AWOS 3000 display. The AWOS core software will continue
to run, with weather data being collected, processed, and logged, and VHF radio and voice
modem output continuing uninterrupted. After exiting, the user will have limited access to the
underlying operating system. They will be able to view system files but not edit them; they will
not be able to stop system services.

58



EDIT MENU

9. Edit Menu

(Keyboard shortcut Alt + e)

The Edit menu (Figure 40) contains options for setting up group and user authorizations, con-
figuring the display and alarm settings, turning AWOS sensor reporting on or off, handling
archive data, and entering voice remarks.

Edit |
Group Authorizations ...
User Authorizations ...

Configuration ...
Alarm Configuration ...
Turn On/Off Sensors ...

Snap Shot Archive
Delete Archive ...

Save Archive ...

Voice Remarks ...

Figure 40. The Edit Menu

Access to some configuration functions requires the CD security key, which is available only to
certified technicians. Refer to Chapter 2 for explanations of those functions.
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9.1 Group and User Authorizations

The AWOS display software is highly configurable through a series of user menus. Often, though,
configuration changes may best be restricted to authorized users. The Group and User structure
of the software allows permission to be allocated as required to control access and maintain the
integrity of system operations. Authorization menus are generally only available to Administrators,
though those permissions can be given to other groups as well.

e Group Authorizations allow administrative functions to be enabled or disabled, new
groups to be created, and access to the three data views to be assigned.

e User Authorizations grant group membership to individual users. A user can belong to
one or more groups. On logging in, the user will be granted access to all the functions
allowed for each group in which he has membership.

e Authorization changes take effect immediately on exiting a configuration dialog and
returning to the main display.

e The “Admin” user is the only user entry required by the system and cannot be deleted.

In the explanations used in this section, the group and user names are only examples (with the
exception of the “Admin” user). Remember that Users and Groups are distinct. In Figure 44, for
example, the user “Admin” is not synonymous with the group “Administrators”, though the
names are similar. With the settings as shown in Figure 44, the user “Admin” and group
“Administrators” do have the same privileges, since only “Group Administrators” is checked. If
“Group Operators” was also checked, however, “Admin” would have all the privileges asso-
ciated with the “Operators” group along with those associated with the “Administrators” group.

60



EDIT MENU AWOS 3000 USER'S MANUAL

9.2 Group Authorizations
(Keyboard shortcut Alt+e then g)

The Group Authorizations... option allows administrators to set group permissions. Note: To
view the entire list, you may need to resize the window or use the scroll bars.

e To configure group permissions, log on as an authorized user with Admin rights and
select Edit > Group Authorizations to call up the screen shown in Figure 41.

Group Authorizations @

Authorization 4 : Historical Manual : Archives Diagnostics Tower
 Name Admin | Alarms | Audio | Config Data | Observations Printer Reports View View View ‘
Administrators v v v v v v ¥ v ¥ v v
Maintenance v | v v v
Operators v | Y s s s v s v v

4 [*]

New ‘ Edit Delete ‘ Done

Figure 41. Group Authorizations Screen

The Group Authorizations screen lists all current groups and the authorized features and display
views available to each. The Authorization Name shows the name of the group, followed by a
series of checkboxes that shows the functions a group is authorized to access. A function is
accessible when it is checked. Table 5 explains each of the functions.

Table 5. Group Authorization Details

Function When Checked

Admin Gives the group administrative privileges, including Group and User
Authorization

Alarms Lets the group acknowledge and disable alarms (System Status menu)

Audio Lets the group record voice remarks (Edit > Voice Remarks)

Config Lets the group change configuration settings and configure alarms (Edit >
Configuration)

Historical Data Lets the group view and retrieve data logs (File > Historical Data)

Manual Observations | Lets the group enter manual observations (Manual Observations menu)

Printer Lets the group control printer operation

Reports Lets the group enter METAR remarks

Archives View Lets the group select the Archives view from the View menu

Diagnostics View Lets the group select the Diagnostics view from the View menu

Tower View Always on
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9.2.1 Adding a Group

To add a new group, click the New button at the bottom of the screen. The screen shown in
Figure 42 will be displayed.

Name: |
Features Views
[ ] Administrator
[ ] Alarms
] Audio [] Archives
[ ] Configuration
[_| Historical Data
[_] Manual Observations V] Tower
[ ] Printer
[ ] Reports

[ ] Diagnostics

Save Cancel

Figure 42. New Group Screen

e Enter a name for the group.

e Select all the features from the Features panel that you want the group to have access to.
e Select all the views from the Views panel that you want the group to have access to.

e Click Save to add the group.

e Click Cancel to return to the Group Authorizations screen without adding the group.
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9.2.2 Editing a Group

To edit a group’s authorizations, highlight a group on the list and click the Edit button at the
bottom of the screen. The screen shown in Figure 43 will be displayed.

Edit Group @

Name:
Features Views
@ Administrator
[v] Alarms
[v] Audio [v] Archives

[v] Configuration
[v| Diagnostics

[v] Historical Data

[v] Manual Observations

[v] Printer

[v] Reports

E} Tower

’ Save H Cancel 1

Figure 43. Edit Group Screen

e Check or uncheck Features and Views to enable (check) or disable (uncheck) access.

e Click Save to save the changes.

e Click Cancel to return to the Group Authorizations screen without saving the changes.

9.2.3 Deleting a Group

To delete a group, highlight the group name on the Group Authorizations screen and click the
Delete button at the bottom of the screen. The group will be deleted immediately. Note: You

cannot delete a group that has a user associated with it. The Administrator group cannot be
deleted.
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9.3 User Authorizations
(Keyboard shortcut Alt+e then u)

The User Authorizations... option allows authorized users to define new users and associate
them with the appropriate groups. Note: To view the entire list, you may need to resize the
window or use the scroll bars.

e To configure user permissions, log on as an authorized user with Admin rights and select
Edit > User Authorizations to call up the screen shown in Figure 44.

User Authorizations @

Authorization Group Group Group ‘
Name Administratars Maintenance Operators
Admin v
Qperator ' v e
< I [»
[ New I ’ Edit ’ l Delete [ } Done J

Figure 44. User Authorizations Screen

The User Authorizations screen lists all current users along the left side and all existing groups
along the top. The Authorization Name shows the name of the user, followed by a checkbox for
each available group. A checkmark beneath a group indicates that the user is a member of that
group with access to all the features associated with the group.
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9.3.1 Adding a User

To add a new user, click the New button at the bottom of the screen. The screen shown in Figure

45 will be displayed.

Name: |

Password: | |
Retype Password:

Groups

[ ] Administrators
[] Maintenance
[ ] Operators

Cancel

Figure 45. New User Screen

e Enter a name for the user.

e Enter a password for the user. Any letter and/or number combination can be used. No
password strength checking is built into the system, so it is the user’s responsibility to
choose a secure password.

e To confirm the password, re-enter it in the Retype Password field.

e Select each of the groups in the Groups panel to which the user will belong.

e Click Save to add the user.

e Click Cancel to return to the User Authorizations screen without adding the user.
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9.3.2 Editing a User

To change a user’s password or change the groups the user belongs to, highlight the user’s name
on the list and click the Edit button at the bottom of the screen. A screen similar to that shown in

Figure 46 will be displayed.

Name:

Password: [sessece

Retype Password: |ssesses

Groups
[v] Administrators
[v] Maintenance

[v] Operators

’ Save H Cancel

Figure 46. Edit User Screen

e To change the user’s password, enter a new password in the Password field.
e To confirm the password, re-enter it in the Retype Password field.

e Check or uncheck groups in the Groups panel to set the groups to which the user will
belong.

e Click Save to save the changes.
e Click Cancel to return to the User Authorizations screen without saving the changes.

9.3.3 Deleting a User

To delete a user, highlight the user’s name on the User Authorizations screen and click the
Delete button at the bottom of the screen. The user will be deleted immediately.
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9.4 Configuration
(Keyboard shortcut Alt+e then c)

When you select Configuration from the Edit menu, the main configuration screen (Figure 47)
appears. The available configuration options are grouped under tabs according to the part of the
system they affect:

Airport
Reports
Sensors
Voice
Misc

YVVVVY

e To access a configuration category, click the appropriate tab at the top of the screen.

e Most categories also provide secondary tabs that group similar options under a common
heading. The Airport tab, for example, is divided into General settings and Runway
settings.

Configuration @

(Birport | Reports | Sensors | Voice | Misc |
“General [ Runways l

Airport Name: AWOS 3000 |

ICAO Identifier

Elevation (MSL):

BP Sensor Elevation (MSL):

BP 1 Offset: inHg

BP 2 Offset: inHg

Ceilometer Elevation (AGL):

Magnetic Declination: (® East ) West
‘ OK I | Cancel 1

Figure 47. Configuration Screen
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9.4.1 Airport Tab
The Airport tab (Figure 48) contains two sub-tabs: General and Runways.

9.4.1.1 General

The Airport > General tab contains a number of options unique to the airport location. Only the
Airport Name is available for general user input. All other settings require the CD security key.
Refer to Section 7.1.1 for details on those options.

Configuration @

[“Rirport | Reports | Sensors | Voice | Misc |
General [ Runways ]

Airport Name: AWOS 3000 |

ICAO Identifier

Elevation (MSL):

BP Sensor Elevation (MSL):

BP 1 Offset: inHg

BP 2 Offset: inHg

Ceilometer Elevation (AGL):

Magnetic Declination: (® East ) West
} OK ‘ ’ Cancel |

Figure 48. Configuration General Tab
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9.4.1.2 Runways

AWOS 3000 USER'S MANUAL

The Airport > Runways tab (Figure 49) contains a single field for specifying the number of the
runway where the AWOS is installed.

Configuration @

[ Airport | Reports | Sensors [ Voice | Misc |

(‘General | Runways I

awos: | 29
’ OK H Cancel ‘

Figure 49. Runways Tab

Table 6. Parameters on the Runways Tab

Runways

AWOS

Enter the number/designation of the runway associated with the AWOS.
The value can consist of a 2-digit number from 1-36, followed by an
optional designator (R or L, for example). Up to four text characters can
be entered in place of numeric values for sites such as helipads that do
not have runway designations.
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9.4.2 Reports Tab

The Reports tab lets you specify parameters for METAR scheduling and NADIN configuration.
9.4.2.1 METAR Tab

The METAR tab (Figure 50) lets you specify the scheduling of METAR report transmissions.
The available reporting intervals are:

e 5 minutes

e 10 minutes
e 15 minutes
e 20 minutes

This value can be changed by the site operator; the CD key is not required. The default setting is

5 minutes. Note that any changes to the METAR reporting interval must be coordinated with the
FAA.

Configuration @
“Rirport | Reports | Sensors | Voice | Misc |

(METAR | NADIN |

Reporting Frequency:

’ OK H Cancel ‘

Figure 50. METAR Configuration Tab
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9.4.2.2 NADIN Tab
The NADIN tab (Figure 51) lets you set NADIN to OFF or ON.

e Set to OFF when NADIN is not installed or to disable NADIN.
e Set to ON to enable NADIN.

Configuration @
" mirport [ Reports | Sensors tVoice [ Misc ‘

[ METAR |  NADIN

Mode: () Off @® On

l OK H Cancel l

Figure 51. NADIN Tab

9.4.3 Sensors Tab

Access to the options found on the Sensors tab requires the CD security key. Section 7.1.2
provides the details.
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9.4.4 Voice Tab

The Voice Configuration tab (Figure 52) lets you set the status of the AWOS voice message,
the playback mode, and enabling or disabling the VHF radio and phone output.

Configuration g|
Airport | Reports | Sensors | Voice Misc
Status Playbhack
® Commissi 1 ) Aut
) Test Mode J Manual
Phone VHF Radio
i@ Enable i@ Enable
) Disable ) Disable
| OK | | Cancel |

Figure 52. Voice Configuration Tab

9.4.4.1 Status

The Status panel of the Voice tab offers two status options.

e Select Commissioned for a system that has been commissioned and is in normal
operation.

e Select Test Mode to transmit a “test” notice in the outgoing voice message. This option
is used prior to commissioning and during maintenance.
9.4.4.2 Playback Mode

The Playback panel lets you select between two playback modes.

e In Automatic mode the outgoing voice message includes all available AWOS weather
data in addition to any manually recorded voice remarks.

e In Manual mode, all automatically generated AWOS weather data is excluded from the
voice output, and only manually recorded voice remarks are output. This mode should
not be used for weather data, since the voice remark will not expire until playback mode
is returned to Automatic.
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9.4.4.3 Enabling Phone Output

The Phone option at the bottom of the Voice tab lets you enable or disable voice output over a
phone line. This might be used when, for example, a phone line is to be used for RMM rather
than voice output. In that case, Phone would be set to Disable.

Set to Enable for normal operation. Set to Disable to suspend phone output.

9.4.4.4 Enabling VHF Radio Output

The VHF Radio option at the bottom of the Voice tab lets you enable or disable voice output
over the ground-to-air VHF radio. This might be used when, for example, the VHF radio is
malfunctioning. In that case, VHF Radio would be set to Disable.

Set to Enable for normal operation. Set to Disable to suspend VHF output. When using the
ATIS/AWOS switch, this should normally be set to Enable.

9.4.4.5 Voice Test Mode

Access to the options found on the Voice tab requires the CD security key. Section 7.1.4
describes the details.
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9.4.5 Misc Tab

The Misc tab lets you specify the number of days to retain logs in the system before deleting
them, set the user timeout period, and control the system’s time source (GPS or computer).

9.45.1 General Tab

The General tab (Figure 53) lets you enter the number of days to retain logs, and to set the
default time period for automatically logging out a user.

e In the Number of Days to Keep Logs text box, enter the number of days the system should
maintain log files before overwriting them. The value can be anywhere in the range of 4
days to 9999 days. (Note: Saved logs will be retained regardless of the value entered
here.)

e In the Default User Timeout text box, enter the number of minutes of inactivity before a
logged-in user is automatically logged out. If a user is logged in, once this time period
has elapsed (with no keyboard or mouse activity detected), the AWOS display will
remain visible, but menu options requiring user login will be grayed out.

e In the Pin for voice remarks over phone text box, enter a 4-digit numeric PIN. The PIN
number is used to enable/disable or add voice remarks via telephone. Although the PIN
may be fewer than 4 numeric digits, four digits ar recommended for maximum security.

Configuration E|
fnirpurt rRepurts rSensors r\p‘uice Misc

General | Time

Number of Days to Keep Logs: A00
Default User Timeout: S000

PIN for voice remarks over phone: 1001

| OK || Cancel |

Figure 53. General Tab
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9.4.5.2 Time Tab
Use the Time tab (Figure 54) to set the GPS receiver as the time source for the AWOS software
or to manually enter the time and date. Use GPS Time should be selected in normal operation;
disable only if the GPS Receiver fails.
e Select Use GPS Time to obtain time and date data from the GPS Receiver.
e To specify the time and date manually, uncheck the Use GPS Time box and enter the
date and time in the corresponding fields. To enter the date, click the calendar icon to

the right of the date field and select the desired date. This option will use the computer’s
built-in clock, which is less accurate than the GPS Receiver.

Configuration @

[ Airport | Reports | Sensors | Voice [ Misc |

[ Generaiﬁ[ Time

Use GPS Time: [v]
Today’s Date (dd/mmiyyyy):
Today's Time (hhimm:ss):

OK H Cancel '

Figure 54. Time Tab
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9.5 Alarm Configuration

Access to the options found on the Alarm Configuration menu requires the CD security key.
Section 7.1.3 provides the details.

9.6 Turn On/Off Sensors

The Turn On/Off Sensors option on the Edit menu allows you to specify the sensor data to
include on the display and in generated reports.

e When a sensor is turned ON, data for that sensor will be displayed and values will be
included in logs and reports.

e When a sensor is turned OFF, the sensor will appear as "missing" on the display and in
reports.

e When a sensor is ON, its value will be included in calculations and when it is OFF, any
calculated values that are dependent on it will be appear as “missing.”

The Sensor Dialog screen shown in Figure 55 is the interface for specifying the data to include.

Sensor Dialog @

Sensor
® On ) Off Barometric Pressure
® On ) Off Cloud Height Indicator
® On ) Off Freezing Rain
® On ) Off Lightning
® On ) Off Motor Aspirated Radiation Shield
® On ) Off Precipitation Identification / Intensity
® On ) Off Tipping Bucket Rain Gauge
@® on O Off Visibility
® On ) Off Wind Speed /Direction
I OK ‘ ‘ Cancel I \ All On l I All Off J

Figure 55. Sensors On/Off Screen
e Select the sensors to be turned ON or OFF individually by clicking On or Off beside the
sensor name.
or
Turn all sensors ON by clicking the All On button at the bottom of the screen.
or
Turn all sensors OFF by clicking the All Off button at the bottom of the screen.

e  When done, click OK to save the settings, or click Cancel to discard any changes made.
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9.7 Handling Archive Data

The three archive data options at the bottom of the Edit menu are used in conjunction with the
Archives View (accessible from the View menu) to create collections of archive data. For details
on using these options, refer to Section 10.4.

9.8 Voice Remark

The Voice Remark option (Figure 56) lets you record up to two 90-second voice remarks to be
appended to the outgoing AWOS voice message.

Note: VHF radio and telephone voice outputs are suspended while the Voice Remark window is

open.

Voice Remark @

Playback
® Automatic

) Manual

[ Remark One " Remark Two |
Enabled: ) On ® Off
Persistent: (> On @ Off

OK || Cancel |

Figure 56. Voice Remark Screen

9.8.1 Recording a Voice Remark

The following steps describe how to record a voice remark.

1.

AN

Click the appropriate tab to select the voice remark to record (VVoice Remark One or
Voice Remark Two).

Click the record button | @ to begin recording the remark.

Speak the remark clearly into the CDP microphone.

When done, click the stop button | ® |,

Set the status, playback mode, and enable output as described below.
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9.8.2 Playback Mode
The Playback panel lets you select between two playback modes.
e In Automatic mode the outgoing voice message includes all available AWOS weather

data in addition to any manually recorded voice remarks.

¢ In Manual mode, all automatically generated AWOS weather data is excluded from the
voice output, and only manually recorded voice remarks are output.

9.8.3 Enabling Voice Output

The Enabled option at the bottom of the Voice Remark screen lets you enable or disable the
voice remark. Voice Remark One and Voice Remark Two are enabled and disabled
independently, so this selection must be made for each.

e Select On to output the voice remark with the outgoing voice message.

e Select Off to suspend output of the voice remark.

9.8.4 Voice Remark Expiration

The Persistent option at the bottom of the Voice Remark screen controls whether the voice remark
expires or is on continually. Voice Remark One and Voice Remark Two are enabled and
disabled independently, so this selection must be made for each.

Note: For remarks containing weather data, Persistent should be set to Off to prevent out-of-
date information being broadcast.

e Select On to have the remark output continually without expiring.

e Select Off to set the remark to expire at 1 second past the top of the hour. With this
option selected, the weather remark will have to be re-enabled to be output again after it
has expired.

9.8.5 Telephone Access to Voice Remarks

Voice remarks may be enabled/disabled or edited by telephone. To use this feature, use the dial-
in telephone number that you would normally use to access the telephone voice output.

1. Press 5 to access the Telephone Access Menu.

2. Enter the PIN (the PIN was created as described in Section 9.4.5.1 followed by the # sign
when prompted.

3. Choose a selection from those offered.

e Press 1 to listen to the current voice remark(s).

e Press 2 to record a new voice remark with a length up to 90 seconds (this will be
Voice Remark 1).

e Press 4 to exit the system.
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4. If you selected 1 to listen to the current voice remark, you will hear the remark and
whether it is active.

e If you are advised the remark is not active, press 1 to make the remark you just heard
active. You will also have the choice to press 2 to create a new voice remark or press
4 to exit.

e If you are advised the remark is active, press 1 to make the remark you just heard
inactive. You will also have the choice to press 2 to record a new voice remark or
press 4 to exit.

e The system will exit automatically once you are done if you selected 1 or 2.

5. Ifyou selected 2 to record a new remark, you will be prompted to record the remark after
the tone. The remark will be played back shortly after you finish making it.

e You will be asked to press 1 to accept the remark or to press 2 to record a new voice
remark.

e You will be advised that the remark is not active, to press 1 to make the remark you
just heard active, or to press 4 to exit.

e The system will exit automatically.

Any remarks activated via the Telephone Access Menu will become inactive automatically 1
second past the top of the hour.
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10. View Menu
(Keyboard shortcut Alt+v)

The View menu (Figure 57) lets you select the data view (Tower, Diagnostics, or Archives).

View |

) Tower
) Diagnostics
® Archives

Figure 57. The View Menu

10.1 Selecting the Data View

The three options on the View menu let you select the data view. Each view contains different
sets of data, and displays that data in different formats.

e To select a view, click the view name on the View menu. In the example above, the
Archives view is selected.

e Not all views may be selectable. The views available to each user are controlled by the
Administrator.
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10.2 Tower View
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Figure 58 shows the Tower View. This display is geared toward control tower use, with wind
data shown on graphic dials and essential parameters organized visually for quick identification.

File Edit View Manual Observations Reports System Status Help (User: Admin)
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10.3 Diagnostics View

The Diagnostics View is shown in Figure 59. The Diagnostics view provides access to system
and sensor level status information. The display is divided into two panes.

The narrow pane on the left side is the navigation pane, which lists the components with
status information available. To select a component, click its name in the navigation
pane.

The main pane shows the status information for the selected component.
Within any screen, warning conditions are shown in YELLOW and failures are shown in

RED |

Sensors that are not installed will still appear in the navigation pane, but all fields in the
main pane will be blank. DCP status bits applying to uninstalled sensors will also be
blank, as will relevant fields in the Sensor Data pane. No alarms will be triggered for
uninstalled sensors.

10.3.1 System Diagnostics

The System Diagnostics screen (Figure 59) is the default screen to which the display opens.

If new, unacknowledged alarms exist, a blinking red ALARM indicator is shown in the
System Status box. A red alarm indicator [@8 is shown in the navigation pane beside
System Diagnostics.

If all alarms have been acknowledged, the AL ARM indicator turns a lighter red (as in
Figure 59), and the navigation pane’s System Diagnostics alarm indicator turns yellow
m.

Running counts of Acknowledged Alarms and Unacknowledged Alarms are shown in two

text boxes. The text boxes will change color to correspond with the state of existing
alarms.

If a sensor or DCP failure occurs, a red alarm indicator [ @ will be shown in the
navigation pane beside the affected component.

If a sensor or DCP warning is present, a yellow alarm indicator [T} will be shown in the
navigation pane beside the affected component.

The On or Off status of the sensors is shown in the Sensor Status panel.
The System Info panel shows the time at which the system was last started.
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[ 15/05/2009

AWOS 3000 KAWI

23:21:01

[@ system Diagnostics
3 DCP
Cloud Height Indicator
@ Freezing Rain
Lightning
Precipitation Identification / Intensity
Visibility
GPS

Alarm Status

Acknowledged Alarms:

Unacknowledged Alarms:

Sensor Status

Barometric Pressure: On
Cloud Height Indicator: on
Freezing Rain: Oon
Lightning: on
Motor Aspirated Radiation Shield: On
Precipitati i ion / it on
Tipping Bucket Rain Gauge: on
Visibility: on
Wind Speed / Direction: On
System Info

1

0

System Status
Phone: On
VHF Radio:  On

System Startup: 15/05/2008 16:16:00

Figure 59. Diagnostics Display
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10.3.2 DCP Diagnostics
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Click the DCP heading in the list pane to call up the display shown in Figure 60. The display is

divided into four panels.

Statistics

Status

Sensor Data

Recent
Responses

file Edit View Manual Observations Reports System Status Help

The Statistics panel provides a summary of DCP
behavior, focused mainly on communications integrity.

The Status panel shows the current status of several DCP

operating parameters.

The Sensor Data panel shows the most recent data
received for each parameter.

The Recent Responses panel shows a real-time record of
incoming DCP poll responses in a scrolling list. The
entries will scroll as new data is received, with the most
recent response at the top of the list. The format of the
DCP message is explained in Appendix A.

(User: Admin)

15/05/2009 AWOS 3000 KAWI 23:23:03
I System Diagnostics Statistics Status
i ilouu Height Ingicator b
Freezing Rain Up Time: 0 days 00:14:25 -5VDC Reference: oK
Lightning Request Count: 174 +5VDC Reference: 0K
B Precipitation Identification / Intensity . 1
Visibility Fesgouse Cotiat L Restarted in Last Minute: No
ore Average Response Rate (ms): 5,001
Response to Request (%): 93.00 Running On Battery: No
CRC Error Count: 0 Maintenance Switch Pressed: No
CRC Error Rate (%): 0.00 MARS Fart: oK
CRC Errors / minute: 0.0000
‘Wind Sensor: 0OK
Test
Elapsed Time: 0 days 00114:25 BP Sensor Low Temperature: 0K
Request Count: 174 BP Sensor High Temperature: OK
[Responsa Count: 173, BP Sensor Communication: 0K
Average Response Rate (ms): 5,001
e A Ceilometer Sensor Communication: 0K
Response to Request (%): 99.00
CRC Error Count: 0 Freezing Rain Controller Communication:  OK
CRC Error Rate (%): 0.00 Lightning Sensor Communication: 0K
CRC Ettoraummee:” = gaurg Precipitation Sensor Communication: | 0K
Reset
et} Visibility Sensor Communication: oK
Time of Last Message: 15/05/2009 16:22:59
Sensor Data
Air Temperature (F): 600 BP 1: 20920 Visibility: 02000 Tips: 00
Dew Point (F): 800  BP2 29920 ALS: 00010 Precipitation Type: =
RH: 0500 WindSpeed: 006 Day/Nightt D  Precipitation Amount: 000
Ceilometer: 000 WindDirection: 080  Lightning: 00018  Freezing Rain: 40000
Recent Responses
Time Delta (ms) Message )
16:22:59.545 5046 006 080 600 500 23920 29520 00 0000 020000 DOOOODZSC! 0500 _5.000 W__P.00050000 0001040
| 162254500/ 4782|7A000000000000000054 005 080 600 800 29920 29920 00 0000 020000 DOO000ZSCO004800000500 S.000 W__P.00050000 0001040
| 16:22:49.718 4337 006 080 600 800 23920 29520 00 0000 020000 DO000OZSC 5.000 W__P.00050000 0001040]
16.22:44.781 5313 1005 080500 800 29920 29920 00 0000 020000 DO0OOOZSC 00500 5.000 U_P.00050000 _0001040]
4812/7A000000000000000039_006 080 600800 29920 00 0000 020000 D000OOZSC0004800000S 0 W__P.00050000 0001040
5000 4 006 080 600 800 28920 29920 00 0000 020000 DO000OZSC s 00050000 0001040
16:22:29.656, 5000(74000000000000000029 006 080600 800 29920 29920 00 0000 020000 DO000D25C0004800000500 §.000 W__F.00050000 0001040
16.22:24 656 5000, 006 080 600 800 29920 29920 00 0000 020000 DO0D0OOZSC 5.000 W__P.000S0000 0001040{=
5000|74000000000000000019 006 080600 800 29920 29920 00 0000 020000 D0000D25C0004800000500 §.000 W__P. 00050000 0001040
5016 14 006 080 600 800 29920 29920 00 0000 020000 DOOOOOZSCH 0500 5.000 W__P.000S0000 0001040
[ 4922(7A000000000000000009 005 080600 800 29920 29920 00 0000 020000 DO00002SCO004800000500 §.000 W__P.00050000 0001040
16:22:04.718 4843 005 080 600 800 28920 29520 00 0000 020000 DODO0OZSC 5.000 W__P.000$0000 0001040
162150875 5422(7A000000000000000059 006 080600800 29920 29920 00 0000 020000 DOD0002SC0004800000500 §.000 W__P.00050000 0001040
16.2154.453 4813) 006 080 600 800 23920 23920 00 0000 020000 DODOODZSC 0500 _5.000 W__P.00050000 0001040] |
16:21:49.640] 5187|7A000000000000000049 006 020 600800 29920 29920 00 0000 020000 DO00002SCO004800000500 §.000 W__P.000S0000 0001040
5000, 005 080 600 500 23920 29520 00 0000 020000 DO000OZSC )0 5.000 W__P.00050000 0001040]
4985[7A000000000000000039_006 080600 800 29920 29920 00 0000 020000 D000002SC0004800000500 5.000 W__P.000S0000 0001040
4828 4 006 080 600 800 29920 020000 D0000OZSC 0500 5.000 W__P.00050000 0001040
5187] 000000000000029 005 080 600 800 20 00 0000 020000 DOOO: 0004800000500 S. 00 00001040
5000{74000000000000000024 006 080 600800 29920 29520 00 0000 020000 D0000GZSC0004000000500 S. 000 0 0001040] |
1157‘\’ 19 006 080 600 800 29920 29920 00 0000 020000 D0O000OZSCOO! 0500 5.000 W__P.00050000 0001040|w
Il I 1»]

Figure 60. DCP Diagnostics Screen

84



VIEW MENU AWOS 3000 USER'S MANUAL

10.3.2.1 Statistics

Statistics for a number of operational parameters are shown in Table 7 to assist the maintenance
technician in isolating a problem.

The Total values represent data logged since power was last cycled on the DCP.

Table 7. Definitions for the Statistics Tab

Shows the time elapsed since the AWOS 3000 server software was last

Up Time started. All the values in this section are in relation to this Up Time.
Request Count Shows the number of poll requests sent by the CDP.

Response Count Shows the number of poll responses received from the DCP.

Average Response Rate | Shows the average time taken for a CDP poll request to be responded to
(ms) by the DCP.

Response to Request Shows the percentage of poll requests that have received responses out
(%) of the total sent.

CRC Error Count Shows the number of CRC errors detected in responses from the DCP

Shows the percentage of DCP responses containing CRC errors out of

CRC Error Rate (%) the total received

Shows the average number of CRC errors per minute detected in

CRC Errors / minute responses from the DCP
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The Test panel (Table 8) allows a technician to view only current data by resetting all values
with a click of the Reset button.

Table 8. Definitions for the Test Panel

Shows the time elapsed since the Reset button was last clicked. All

Elapsed Time values in this panel are in relation to this Elapsed Time.

Request Count Shows the number of poll requests sent by the CDP.

Response Count Shows the number of poll responses received from the DCP.

Average Response Rate | Shows the average time taken for a CDP poll request to be responded to
(ms) by the DCP.

Response to Request Shows the percentage of poll requests that have received responses out
(%) of the total sent.

CRC Error Count Shows the number of CRC errors detected in responses from the DCP

Shows the percentage of DCP responses containing CRC errors out of

CRC Error Rate (%) the total received

Shows the average number of CRC errors per minute detected in

CRC Errors / minute responses from the DCP

Click to reset the Test panel values to zero. Does not affect the values in
the Total panel.
Time of Last Message Shows the time at which the last response from the DCP was recorded.
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10.3.2.2 Status

The Status panel shows the current status of a number of DCP components (Table 9). When a
warning condition exists, the status will be shown in YELLOW. If a failure occurs, the status will

be shown in [{E1).

Table 9. DCP status Indications

Field Indications | Description Warning or Error
. Shows the current status of the DCP power
-5VDC Reference OK or Failed supply's -5/ DC reference Error
. Shows the current status of the DCP power
+5 VDC Reference OK or Failed supply's +5 V/ DC reference Error
Restarted in Last Shows whether the DCP has been restarted in .
. Yes or No . Waming
Minute the past minute
Indicates whether the DCP is running on battery
Running on Battery Yes or No or line power. Ye§ |nd!caFes thel DCP is running Warning
on battery power; No indicates it is running on
line (AC) power
Maintenance Switch Yes orNo Indicates whether the maintenance switch within Warnin
Pressed the DCP has been pressed. 9
Indicates Failed when the fan within the MARS
MARS Fan OK or Failed unit is not working correctly. When the MARS Error
fan fails, all temperature and RH values will be
shown as missing.
Wind Sensor OK or Failed Shows Failed if no data is received from the Error
wind sensor
BP Sensor Low . Indicates Failed if the BP sensor's temperature
OK or Failed . ; Error
Temperature drops below the minimum operational tolerance
BP Sensor High . Indicates Failed if the BP sensor's temperature
OK or Failed . ) ; Error
Temperature rises above the maximum operational tolerance
BP Sensor . Shows Failed if no data is received from the BP
L OK or Failed Error
Communication sensor
Ceilometer Sensor . Shows Failed if no data is received from the
o OK or Failed . Error
Communication ceilometer
Freezing Rain Sensor OK or Failed Shows Failed if no data is received from the Error
Communication freezing rain sensor
Lightning Sensor . Shows Failed if no data is received from the
Communication OK or Failed lightning detector Error
Precinitation Sensor Shows Failed if no data is received from the
piiation OK or Failed present weather (precipitation ID & intensity) Error
Communication
sensor
Visibility Sensor . Shows Failed if no data is received from the
Communication OK or Failed visibility sensor Error
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10.3.2.3 Sensor Data

The Sensor Data panel (Figure 61) shows the most recent data received from each of the sensors.
These values are updated each time a new message is received from the DCP.

Sensor Data
Air Temperature (F): 600 BP 1: 29920 \isibility: 02000 Tips: 02
Dew Point (F): 800 BP 2: 28920 ALS: 00010  Precipitation Type: P-
RH: 0500  Wind Speed: 006 Day / Night: D Precipitation Amount: P.000
Ceilometer: 050  Wind Direction: 096  Lightning: 00000 Freezing Rain: 00000

Figure 61. Sensor Data Panel

When data from a sensor is missing, it is represented in the Sensor Data panel by a blank entry,
as opposed to the slashes (//) used in the Tower View. Slashes are only used in this panel when
communication between the DCP and CDP has been lost.

10.3.2.4 Recent Reponses

The Recent Responses panel displays all incoming poll responses from the DCP as they are
received. Once the list is full, the entries will scroll, with the most recent response at the top of
the list.

e The Time field shows the time at which the response was received

e The Delta (ms) field shows the elapsed time between the selected response and the
response of the same type preceding it.

e The Message field shows the raw data message.

The format of the DCP message is explained in Appendix A.
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10.3.3 Cloud Height Indicator Diagnostics

The Cloud Height Indicator diagnostics screen (Figure 62) shows the individual components of
the Model 8339 Ceilometer’s status word, which is transmitted in each data packet.

file Edit View Manual Observations Reports System Status Help (User: Admin)

15/05/2009 AWOS 3000 KAWI 23:21:43

Status

Automatic Gain Control: oK
Blower Heater: off
Blower Heater: oK
Configuration: oK
Control Board: oK
Door Open: oK
Laser Power: 0K
Laser Temperature Control: 0K
Laser Temperature Low: oK
Laser Temperature High: oK
Missing Pulse: oK
Optical Module: oK
Optical Module Heater: oK

Optical Module Temperature: 0K
Receiver Board: oK
Supply Voltage: oK
Window Dirty: No

Figure 62. Cloud Height Indicator Diagnostics Screen

A brief explanation of each of the status fields shown on the diagnostics display is given in Table
10. Detailed explanations of each of these status items are provided in the Model 8339 Laser
Ceilometer User's Manual, 8339-F-001. When a warning condition exists, the status will be
shown in YELLOW . If a failure occurs, the status will be shown in [[32).

Since the ceilometer is capable of discerning levels of error, any of the ceilometer status fields
can indicate either a warning or a failure, depending on the severity of the condition. If a
warning condition exists and is not addressed, it will progress to failure status. The status field
will then change from YELLOW to [{E0).
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Table 10. Definitions for the Ceilometer Status
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Field Indications | Description Warning or Error
Automatic Gain ; If Failed, indicates an error in the Automatic Gain Control
OK or Failed

Control software.

Blower Heater Onor Off |Indicates whether the Blower/Heater is currently powered on.

Blower Heater OK or Failed | Indicates the status of the Blower/Heater

Configuration OK or Failed If Failed, indicates the gonﬂgurahon information has not been
loaded or the firmware is corrupted

Control Board OK or Failed If Ealled, the Control Board must be replaceq before the
ceilometer can be returned to normal operation
Indicates whether the ceilometer enclosure door is open
(Failed) or closed (OK); triggered by the door’s interlock
switch.

D .

oor Open OK or Failed When the interlock switch has been placed in the bypass

mode, the Door Open field would indicate the door is closed
(OK).

Laser Power OK or Failed II‘r;\cj(laclates Failed if laser power drops below the acceptable

Ic_:i?ﬁ:;liemperature OK or Failed | Indicates the status of the Ceilometer’s Peltier device Either, depending on

severity
Laser Temperature : Indicates Failed if the laser temperature drops below the
OKor Failed | . .
Low minimum operational tolerance
Laser Temperature . Indicates Failed if the laser temperature rises above the
. OK or Failed . )

High maximum operational tolerance
Indicates Failed if an expected return laser pulse was not

Missing Pulse OK or Failed | detected. Could be due to a number of causes; use in
combination with other status conditions to determine cause

Optical Module OK or Failed If Ealled, the Optical Module must be replaged before the
ceilometer can be returned to normal operation

Optical Module Heater | OK or Failed | Indicates the status of the Optical Module's heater

Optical Module OK or Failed If Failed, indicates the Optical Module's temperature is out of

Temperature tolerance

Receiver Board OK or Failed If Ealled, the Receiver Board must be replaged before the
ceilometer can be returned to normal operation

Supply Voltage OK or Failed | If Failed, indicates the main voltage supply has been lost

Window Dirty OK or Failed | If Yes, indicates the ceilometer lenses need cleaning
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10.3.4 Freezing Rain Diagnostics

The Freezing Rain diagnostics screen (Figure 63) shows the status of the Model 6495 Freezing
Rain sensor components.

file Edit View Manual Observations Reports SystemStatus Help  (User: Admin)
15/05/2009 AWOS 3000 KAWI 23:21:58

I® System Diagnostics
3

loud! Height Indicator
@ Freezing Rain
L

ing
recipitation Identification / Intensity

Visibility
GPS

Status
Normal Operation: Yes
Field Calibration: No
Deicing Operation: No
Probe: 0K
Deicing: 0K
Electronics: oK
Sensor Reporting to Controller: oK

Sensor Communication to Controller: 0K

Figure 63. Freezing Rain Diagnostics Screen
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A brief explanation of each of the status fields shown on the diagnostics display is given in Table
11. When a warning condition exists, the status will be shown in YELLOW . If a failure occurs,
the status will be shown in [T},

Table 11. Definitions for the Freezing Rain Sensor Status

Field Indications Description Warning or Error

Normal Operation Yes or No Indicates Yes if the sensor is functioning Warning
normally

Field Calibration Yes or No Indicates Yes if a field calibration is in Warning
progress

Deicing Operation Yes or No Indicates Yes if a deicing cycle is in progress Warning

Probe OK or Failed If Failed, the sensor probe is not functioning Error
properly

Deicing OK or Failed If Failed, a sensor deicing cycle was not Error
completed successfully

Electronics OK or Failed If Failed, the sensor’s electronics have Error
reported a fault

Sensor Reportind to If Failed, the sensor is not reporting data

porting OK or Failed | and status to the controller board (located Error

Controller s
within the DCP enclosure)

Sensor If Failed, the DCP is unable to communicate

Communication to OK or Failed | with the controller board (located within the Error

Controller DCP enclosure)
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10.3.5 Lightning Diagnostics

The Lightning diagnostics screen (Figure 64) shows the status of the Model 6500 Thunderstorm/
Lightning Sensor components.

file Edit View Manual Observations Reports SystemStatus Help  (User: Admin)

15/05/2009 AWOS 3000 KAWI 23:22:10

Status
Status Code: 00
Antenna: 0K
Antenna Change Request:  OK
Processor | Antenna: oK
Configuration Changed: No
Communication Buffer: oK
DSP Processor: oK
DSP Processor Memory: 0K
Heading Reference 0K
Main Processor: 0K
Main Processor Memory: K
Main or DSP Processor: 0K
Message: 0K
Microphone: 0K
Request: 0K
Serial Communication: oK
Serial Header: 0K
XYZ Input: oK

Figure 64. Lightning Diagnostics Screen

A brief explanation of each of the status fields shown on the diagnostics display is given in Table
12. When a warning condition exists, the status will be shown in YELLOW . If a failure occurs,
the status will be shown in [[T=5].

93



VIEW MENU

Table 12. Definitions for the Thunderstorm/Lightning Sensor Status

AWOS 3000 USER'S MANUAL

Field Indications Description Warning or Error
. 00 indicates normal operation; other values indicate an
Status Code Numeric error, which will be denoted in one of the fields below Error
Antenna OK or Failed Inqcates Failed if there is an antenna or antenna Error
wiring problem
Antenna Chande Indicates Failed if a request was received to change
g OK or Failed | the antenna mount to a location that does not Error
Request ; L
match the configuration jumpers
Indicates Failed if there have been invalid or missing
Processor/Antenna OK or Failed | internally generated test strikes; possible causes are a Error
noisy antenna location or antenna wiring problem
Confiquration Indicates Yes if the antenna location (determined
9 Yes or No by processor jumpers) has changed since the Error
Changed
system was last powered up
Communication Indicates Overload if the communication buffer has .
OK or Overload ) o Warning
Buffer become full; some data loss is likely
DSP Processor OK or Failed Indicates Failed if there is an error in the DSP Error
processor
DSP Processor . Shows Failed if there is an error in the DSP
OK or Failed ) Error
Memory processor's memory
Heading Reference OK or Failed | If Failed, contact AWI Customer Support Error
Main Processor OK or Failed Indicates Failed if there is an error in the main Error
processor
Main Processor . Shows Failed if there is an error in the main
OK or Failed , Error
Memory processor's memory
Main or DSP . Shows Failed if an error has occurred in either the
OK or Failed . Error
Processor main or DSP processor
Message OKorlnvalid | Shows Invalid if the sensor message is corrupted Warning
Microphone OK or Stuck Shows Stuck if the microphone key has been asserted Error
for 60 seconds or more
Request OK or Invalid Shows Invalid if a poll command was not received Warning
properly
Serial . Shows Failed for communication errors, such as no
i OK or Failed . . Error
Communication data, wrong baud rate, excessive noise, etc.
Serial Header OK or Failed Shows Failed if an error is detected in the message Error
header
XYZ Input OK or Failed | If Failed, contact AWI Customer Support Error
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10.3.6 Precipitation Identification/Intensity Diagnostics

The Precipitation Identification/Intensity diagnostics screen (Figure 65) shows the status of
the Model 6490 Present Weather Sensor components.

file Edit View Manual Observations Reports System Status Help (User: Admin)

15/05/2009 AWOS 3000 KAWI 23:23:31

leight Indicator

0 Rain
Lightning
Precipitation Identification / Intensity|
8 Visibility

GP3

Status
Automatic Gain Control Card: 0K
Electronics Power Supply: OK
Heater Power Supply: OK
Reset: No
Sensor Head Assembly: oK
Signal Processor 1 Card: oK
Slgnal Processor 2 Card: oK
Transmit Modulator Card: 0K

Figure 65. Present Weather Diagnostics Screen
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A brief explanation of each of the status fields shown on the diagnostics display is given in Table
13. When a warning condition exists, the status will be shown in YELLOW . If a failure occurs,

the status will be shown in [T},

Table 13. Definitions for the Present Weather Sensor Status

Field Indications | Description Warning or Error

Automatic Gain If Failed, the Automatic Gain Control PCB must be

Control Card OK or Failed | replaced before the sensor can be returned to Error
normal operation (not field-replaceable)

Electronics Power If Failed, the Electronics Power Supply must be

Suppl OK or Failed | replaced before the sensor can be returned to Error

PPy normal operation

If Failed, the Heater Power Supply must be

Heater Power Supply | OK or Failed | replaced before the sensor can be retumed to Error
normal operation

Reset Yes or No r:sltcgt;si%et: ;f the sensor has been reset in the Warning

Sensor Head If Failed, the sensor assembly must be replaced

Assembl OK or Failed | before the sensor can be returned to normal Error

y operation

Sianal Processor 1 If Failed, the Signal Processor 1 PCB must be

Cagr d OK or Failed | replaced before the sensor can be returned to Error
normal operation (not field-replaceable)

Sianal Processor 2 If Failed, the Signal Processor 2 PCB must be

C'c?r d OK or Failed | replaced before the sensor can be returned to Error
normal operation (not field-replaceable)

Transmit Modulator If Failed, the Transmit Modulator PCB must be

Card OK or Failed | replaced before the sensor can be returned to Error
normal operation (not field-replaceable)
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10.3.7 Visibility Diagnostics

The Visibility diagnostics screen (Figure 66) is divided into four panels.

Configuration The Configuration panel shows the current

configuration of the visibility sensor.

Mode The Mode panel shows OK or FAILED status for the
visibility sensor’s four operating modes.

Emitter/Detector  The Emitter/Detector panel shows the status of each of
the four sensor heads and their associated heaters.

Other The Other panel contains miscellaneous status data to
aid in troubleshooting problems and gauging the overall
operation of the sensor.

When a warning condition exists, the status will be shown in YELLOW . If a failure occurs, the
status will be shown in [{32).

file Edit View Manual Observations Reports SystemStatus Help  (User: Admin)
15/05/2009 AWOS 3000 KAWI 23:23:46
Configuration HMode
Averaging Interval: 3 Minutes
Mode 0, Direct: 0K
OutputInterval: 10 Seconds
Mode 0, Indirect: 0K
Output Type: . Coeff
Mode 1, Direct:  OK
Units: Miles
Mode 1, Indirect:  OK
Error: OK
Emitter ( Detector Other
Emitter 0: oK
Power Supply: OK
Emitter 1: oK
Complete Data: 0K
Detector 0: oK
Missing Data: oK
Detector 1: oK
Window Dirty: oK
Emitter 0 Hoater: | OK
Operating Heads: ]
Emitter 1Heater: 0K
Cross Check: oK
Detector 0 Heater: 0K
ALS or DayNight Heater: 0K
Detector 1Heater: 0K

Figure 66. Visibility Diagnostics Screen
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10.3.7.1 Configuration

The visibility sensor has several configuration options (Table 14) that are set via the visibility con-
troller. The Configuration panel shows the current configurations settings. Note that the settings
cannot be changed through this screen; any changes must be made at the visibility controller.

Table 14. Definitions for the Visibility Sensor Configuration Panel

Field Description

The visibility calculates average values of collected data internally, then
outputs the average to the DCP. This field shows the averaging interval
currently in effect. Possible seftings are: 3 minutes, 5 minutes, or 10
minutes.

Averaging Interval

This field shows the frequency with which data is output to the DCP.

Output Interval Possible settings are: 10 seconds, 1 minute, 5 minutes, or 10 minutes

This field shows the type of data being output by the sensor. Data can

Output Type be output either as visibility values or as extinction coefficient.
. This field indicates the units of measure for output data, and can be
Units . . .
either miles or kilometers.
Error This field shows any errors detected by the sensor's internal

diagnostics.

10.3.7.2 Mode
The Mode panel (Table 15) shows OK or Failed for the visibility sensor’s four operating modes.

During normal operation, the visibility sensor alternates between Mode 0 and Mode 1 operation
with a period of 15 seconds. Each half cycle, a new pair of detector measurements is acquired
(one direct and one indirect). The measurement cycle period is 1 minute long, with 30 seconds
spent in each mode.

A Failed status indicates problems with one of the four heads. The source of these errors can be
further narrowed down by checking status for the individual heads in the Emitter/Detector panel.
If only one head has failed, the field will show a warning (YELLOW). If more than one head fails,
an error ([{31) will be indicated.

Table 15. Definitions for the Visibility Sensor Mode Panel

Field Description Indications

Mode 0, Direct Direct measurement between Emitter 0 and Detector 1 OK or Failed

Mode 0, Indirect Scatter measurement between Emitter 0 and Detector 0 OK or Failed

Mode 1, Direct Direct measurement between Emitter 1 and Detector O OK or Failed

Mode 1, Indirect Scatter measurement between Emitter 1 and Detector 1 OK or Failed
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10.3.7.3 Emitter/Detector

The Emitter/Detector panel (Table 16) shows OK or Failed for the visibility sensor’s four heads
and four heaters (one in each head). A Failed status indicates a failure of the head, or dirt or
contaminants on the sensor window. If only one head has failed, the field will show a warning

(YELLOW). If more than one head fails, an error ({32) will be indicated.

Table 16. Definitions for the Emitter/Detector Panel

Field Indications
Emitter 0 OK or Failed
Emitter 1 OK or Failed
Detector 0 OK or Failed
Detector 1 OK or Failed
Emitter 0 Heater OK or Failed
Emitter 1 Heater OK or Failed
Detector 0 Heater OK or Failed
Detector 1 Heater OK or Failed
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10.3.7.4 Other

The Other panel (Table 17) shows status information for several parameters that can be used in
the troubleshooting of sensor problems.

Table 17. Definitions for the Visibility Sensor "Other” Panel

Field Indications Description Warning or Error
Indicates whether the sensor is operating from .
Power Supply AC or Battery battery or AC power Warning
Complete Data Yes or No Yes indicates complete data is being received Warning
from all heads
Missing Data Yes or No Yes indicates incomplete data is being received Error
from at least one head
Failed indicates that contaminants (dust, etc)
. . . have accumulated on the emitter or detector .
Window Dirty OKor Failed windows. Cleaning the windows should clear this Warning
error
Indicates whether the sensor is operating in 4
head (normal) mode or 3 head mode. Three-
headed operation is initiated automatically when
Operating 4or3 the software determines that one of the sensor Warnin
Heads heads is not functioning properly. In this mode, g
special algorithms are used to determine
visibility based on the outputs of the three
operational heads
Cross Check OK or Failed :’:aaiII(!,?jd indicates one of the sensor heads has Warning
ALS or Failed indicates the heater has failed on the
Day/Night OK or Failed | Ambient Light Sensor or Day/Night Sensor, Error
Heater whichever is installed.
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10.3.8 GPS Diagnostics

The GPS diagnostics screen (Figure 67) shows the status of the GPS unit.

file Edit View Manual Observations Reports System Status Help (User: Admin)

15/05/2009 AWOS 3000 KAWI

ud Height Ingicator
g Rain

Status
Latitude:
Longitude:
Serial Port:
Drift Count:
Active:

GPS Error:
Last Updated:

3838.6477N
12129.3089v
0
Yes

No
1510612009 16:17:00

Figure 67. GPS Diagnostics Screen

AWOS 3000 USER'S MANUAL

23:17:50
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A brief explanation of each of the status fields shown on the diagnostics display is given in Table
18 below. The only GPS field that will show an error is the GPS Error field. When an error is
detected, Yes will be shown in this field in EE If the Active field displays No continuously
for longer than one hour, an alarm will be generated. The other fields are informational, and will

show a current value or will be blank.

Table 18. Definitions for the GPS Diagnostics Screen

AWOS 3000 USER'S MANUAL

Field Indications Description Warning or Error
Latitude Decimal Latitude of the site in decimal format None
Degrees
Longitude gemmal Longitude of the site in decimal format None
egrees
Serial Port Number Number of the serial port the GPS is connected to None
Drift Count Number Number.of tlmes_ the GPS clock has been None
automatically adjusted
Active Yes or No If Yes, the GPS is connected and reporting None
GPS Error Yes or No If Yes, the GPS has reported an error Error
Last Updated | Date & Time ggtg and time of the last message received from the None
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10.4 Archives View

The Archives view (Figure 68) provides access to stored data logs. Using the archive options on
the Edit menu, you can take a “snap shot” of data at a specific point in time for later reviewing.

Note: With the exception of Site ID (contained in the archive headers), site-specific parameters

are not logged.

Data entered manually will be displayed inside angle brackets, <kawr 100510..>, for example.

The three archive data options at the bottom of the Edit menu are used in conjunction with the
Archives View to create collections of archive data.

file Edt View Manual Observations Reports SystemStatus Help  (User: Admin)

10/03/09 AWOS 3000 KAWI 16:52:36

“OneMinute. 20090310109 |
AU253000 One Minuce Reporc -
201 i

o [ Communication Status
o~ 3 DCP Message

o CIMETAR

¢ (3 One Minute

SKY THF DP RH AT RMK
ovco70 6 6

ovcoro
o0vco70
0vCo70
0vC070
ovco70
ovcoro
0vCo70
0veo70
0vCo70
ovcor0
oveeTo
oveo70
0vC070
0vCo70
ovco70
ovcoT0
o0vCo70
0vC070
oveor0
o0vco70
ovcero
0vC070
0v0070
ovcor0
ovco70
ovcoro
0vC070
oveo70
ovcor0
0vCo70
oveoT0
0vc070
ovco70
ovceTo
o0veo70
0vCo70
0vC070
ovcorn
ovCo70
ovCo70
0vC070
ovco70
ovcoro
oveero
0vCO70
0vC070
ovco70
ovco70
ovee7o
0¥C070
1275 OVCO70

[ OneMinute 20080302 log
[ Bneninute 2008031010z
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Figure 68. Archives View
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10.4.1 Navigation and Data Panes

The Archives view is divided into two panes—the Navigation Pane on the left, and the Data
Pane on the right.

e The Navigation Pane shows a hierarchy of all archived data. At the top level of the
hierarchy is the Active folder, which contains all the automatically generated log files.
(Manually generated Snap Shot archives—explained in the next section—are placed at
the same level as the Active folder, labeled by date and time.) Beneath this top level are
archive folders containing specific types of archived data logs—for example, Alarm logs,
METAR logs, etc.) Archive folders can be expanded or contracted by clicking the
open/close icon 7 to the left of the folder. By navigating down through the hierarchy, the
desired log file can be located.

e The Data Pane shows the contents of the selected log file. To display the contents of a
file, click its name in the navigation pane. Note: The data in this pane are not updated
dynamically. To refresh the contents, click another archive in the navigation pane, then
return to the desired archive (click it again in the navigation pane) to view the updated
data.

e Click Close to close the log file currently displayed.

10.4.2 Snap Shot Archive

Using the Snap Shot Archive command on the Edit menu, collected data can be frozen at a
specific point in time.

e When you click the Snap Shot Archive option, a new archive folder is created that
contains all the data logs collected up to that moment. This folder is named according to
the date and time at which it was created, and is located at the top level of the hierarchy.
Use the open/close icons 7 to navigate through the archive’s subfolders.

10.4.3 Delete Archive

In Archives View, the Delete Archive option on the Edit menu is used to delete a snap shot
archive. You must be logged in as an Administrator to select this option. Automatically
generated archives cannot be deleted manually.

e To delete a snap shot archive, highlight the archive in the navigation pane, then click
Delete Archive on the Edit menu. You will be asked to confirm your selection. If you
click OK, the archive will be deleted.

104



VIEW MENU AWOS 3000 USER'S MANUAL

10.4.4 Save Archive

In Archives View, the Save Archive option on the Edit menu is used to back up a snap shot
archive to the CD drive. Automatically generated archives cannot be selected for saving. To save
a snap shot archive to CD:

Ensure that a CD is loaded in the CD writer.
Highlight the archive in the navigation pane, then click Save Archive on the Edit menu.

3. A screen will appear (Figure 69) that allows you to select the specific file types within the
archive to save. To save all the files of a certain type (Alarm, for instance), click the box
beside the folder; a checkmark will appear to show it is selected. To select specific files
within the folder, click the open/close icon ¥~ beside the folder to view the contents of the
folder. Click the desired files within the folder to select them for saving; a checkmark
will be shown beside selected files.

Click Save to copy the files to CD.
5. Click Cancel to exit without saving any files.

Save Archive - March 10, 2009 16:54:21 3

[] Alarm

[[] Communication Status
[[] DCP Message

[ METAR

[_] One Minute

[] Printer

[] system Status

=

Figure 69. Save Archive Selection Screen

105



MANUAL OBSERVATIONS MENU

11. Manual Observations Menu
(Keyboard shortcut Alt+m)

The Manual Observations menu (Figure 70) lets you enter manual observations for the primary
meteorological parameters.

Manual Observations |

Air Pressure ...

Air Temperature ...
Clouds ...

Lightning ...
Precipitation ...
Present Weather ...
Visibility ...

Figure 70. The Manual Observations Menu

11.1 Manual Observations and Automatic Data

The AWOS 3000 software allows users to enter manual observations in place of the AWOS
automatic data. When a manual observations is active, the manual data replaces the data gener-
ated automatically. When the manual observation expires, automatic data reporting resumes
(unless the sensor has been turned off via the Edit > Turn On/Off Sensors option). How this
transition is handled in data processing depends on the parameter.

e For Precipitation and Lightning, automatic data is ignored while the manual observation
is in effect. When it expires, the manual observation is discarded and automatic reporting
begins from scratch.

e For Clouds and Present Weather, automatic data continues to be incorporated into the
algorithm (though not displayed) while the manual observation is in effect. When it
expires, the manual observation is discarded and the automatic value generated by the
algorithm is displayed.

e For parameters where an average value is reported (Air Pressure, Air Temperature, and
Visibility), the value displayed when the manual observation expires depends on the
setting of the Clear Averages option on the Manual Observation screen:
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% If Clear Averages is not selected, averages continue to be calculated in the back-
ground while the manual observation selection is in effect, with the manual obser-
vation treated as the sensor input. The calculated average is displayed until the
manual observation expires. The displayed value will move gradually from the
manual observation value toward the current automatically measured value as
new data are incorporated into the average. The text color will return immediately
to yellow once the manual observation expires, even though the manual observa-
tion is being included in the calculated average.

X/
°e

If Clear Averages is selected, past data are cleared and averages are not calcu-
lated while the manual observation is in effect. When the manual observation
expires, averaging of automatically measured data begins anew. The sensor will
be reported as missing until sufficient data are gathered to calculate a valid
average.

11.2 Manual Observation Text Colors

When a manual observation is active, the value on the Tower display will be shown in BLUE
text. When the manual observation expires, the text will return to the normal yellow color.

If any value used in determining present weather is based on a manual observation (visibility, for
example), the present weather value will also be shown in BLUE text.
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11.3 Air Pressure Manual Observation
(Keyboard shortcut Alt+m then p)

The Air Pressure Manual Observation screen (Figure 71) lets you enter a manual observation for
air pressure in place of the value generated automatically.

When set to Manual, sensor
values must be entered manually

Whenselis Aitomatie: the on this screen. Automatically

values generated automatically Manual Obs. - Air Pressure ! | Jenteied Yakies Wil b lgHored.

by the AWOS will be used for
display, output, and logging. In ® Automatic  Manual
automatic mode, the manual 3 N Enter a value for
observation entry fields are Barometric Pressure: —1  barometric pressure in
grayed out. the text box. Grayed-out
Clear Averages: [] in Automatic mode.
OK Cancel
Check to prevent any previously logged
values from being considered in
calculating upcoming averages.
Click to exit and save Click to exit and discard
entered data. entered data

Figure 71. Air Pressure Manual Observation Screen
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11.4 Air Temperature Manual Observation
(Keyboard shortcut Alt+m then t)

The Air Temperature Manual Observation screen (Figure 72) lets you enter manual observations
for air temperature, dew point, and relative humidity in place of the values generated automati-
cally. Values for all three parameters must be entered manually—the system cannot calculate
related values (it cannot, for example, calculate dew point from temperature and humidity values
entered manually.)

When set to Manual, sensor
values must be entered manually
on this screen. Automatically
generated values will be ignored.

Manual Obs. - Air Tempe.. @

When set to Automatic, the values ® Automatic ) Manual

generated automatically by the Enter a value for air temperature in the text

AWOS will be used for display, Air Temperature: ——— box. Grayed-out in Automatic mode.

output, and logging. In autqmatic Dol Point: | Enteravalue for.dew point !n the text

mode, the manual observation : box. Grayed-out in Automatic mode.

entry fields are grayed out. Relative Humidity: —% —— Enter a value for relative humidity in the
Clear Averages: ] text box. Grayed-out in Automatic mode.

OK Cancel
| |

Check to prevent any previously
logged values from being considered
in calculating upcoming averages.

Click to exit and Click to exit and
save entered data. discard entered data

Figure 72. Air Temperature Manual Observation Screen
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11.5 Clouds Manual Observation
(Keyboard shortcut Alt+m then c)

The Clouds Manual Observation screen (Figure 73) lets you enter manual observations for up to
three cloud layers, along with sky condition and vertical visibility in place of the values generated
automatically. Table 19 is a guide to the abbreviations used on the Manual Observations screen.

When set to Automatic, the values When set to Manual, sensor
generated automatically by the values must be entered manually
AWOS will be used for display, on this screen. Automatically
output, and logging. In automatic Manual Obs. - Clouds . generated values will be ignored.
mode, the manual observation
eniryfieldsaragrayediout ‘@) Automatic () Manual

Click to activate the cloud layer Amount  Height _ Type

and enable a manual observation
to be entered. Higher layers are
only selectable when lower layers

| Select a cloud type description

e \ from the drop-down list.

Rt I~ Enter the base height of the

R / Layer 3: | ‘ cloud layer, in hundreds of feet.
. Vertical Visibility: ——  — If conditions demand, enter a
Select a sky condition vertical visibility value here.
description from the Amount oK Carai Otherwise, leave this field blank.
drop-down list that describes

the cloud layer's coverage.

Click to exit and Click to exit and
save entered data  discard entered data

Figure 73. Clouds Manual Observation Screen

Table 19. Guide to Cloud Abbreviations

Amount Cloud Type
FEW few (1-2 oktas) CB cumulonimbus
SCT scattered (3—4 oktas) TCU towering cumulus
BKN broken (5-7 oktas)
ovC overcast (8 oktas)

Cloud Type is an optional field, and should only be used when a qualified observer has deter-
mined that a given cloud type is present.

The cloud type (if entered manually) and heights are shown in the Tower View display under
Sky Condition, and are logged. The Sky Condition field shows a cloud cover description
followed by the height(s) of the cloud base.
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11.6 Lightning Manual Observation

(Keyboard shortcut Alt+m then I)

AWOS 3000 USER'S MANUAL

The Lightning Manual Observation screen (Figure 74) lets you enter manual lightning
observations in place of the automatically generated data.

When set to Automatic, the values
generated automatically by the
AWOS will be used for display,
output, and logging. In automatic
mode, the manual observation

entry fields are grayed out. ———F——® Automatic  Manual

Select a range value; this
indicates how near the airport
lightning is being detected.

Manual Obs. - Lightning

@

L In Vicinity (5-10

10 - 30 NM Range

® No Lightning (0-

10 NIV)

L ) At Airport (0-5 NM)

NIM)

NW N NE
W E
SW SE

OK Cancel

Click to exit and Click to exit and
save entered data discard entered data

Figure 74. Lightning Manual Observation Screen

When set to Manual, sensor
values must be entered manually
on this screen. Automatically
generated values will be ignored.

Click to select the octants in
which lightning is present;
multiple octants can be
selected. Click again to
de-select an octant.
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11.7 Precipitation Manual Observation
(Keyboard shortcut Alt+m then n)

The Precipitation Manual Observation screen (Figure 75) lets you manually enter a precipitation
accumulation value in place of the value generated automatically. The precipitation entered
manually should be the accumulation since the top of the hour.

When set to Automatic, the

values generated automatically When set to Manual, sensor
by the AWOS will be used for - values must be entered manually

display, output, and logging. In Manual Obs. - Precipit... @ on this screen. Automatically
automatic mode, the manual  ~~~—__ generated values will be ignored.

observation entry fields are @ Automatic Manual
grayed out.
Precipitation (inches)
Enter a precipitation 1 Hour:
value in inches.
OK Cancel
Click to exit and Click to exit and

save entered data discard entered data

Figure 75. Precipitation Manual Observation Screen
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11.8 Present Weather Manual Observation

(Keyboard shortcut Alt+m then w)

AWOS 3000 USER'S MANUAL

The Present Weather Manual Observation screen (Figure 76) lets you enter manual observations
for two present weather groups in place of the values generated automatically. Table 20 contains

the relevant abbreviations.

When set to Automatic, the values

generated automatically by the
AWOS will be used for display,

output, and logging. In automatic \

mode, the manual observation
entry fields are grayed out.

Select a present weather descriptor from
the drop-down list. The options will vary
depending on the Intensity value chosen.

Select up to two present weather
phenomena from the drop-down
lists. The options will vary depending
on the Descriptor chosen.

\

Intensity:

& Automatic

— Descriptor:

Phenomena:
Phenomena:

Manual Obs. - Present We... @

" Manual

_Group 1 Group 2

OK

} Cancel

Click to exit and
save entered data discard entered data

Click to exit and

Figure 76. Present Weather Manual Observation Screen

When set to Manual, sensor
values must be entered manually
on this screen. Automatically
generated values will be ignored.

Select an intensity value from the
drop-down list. The value selected
here determines the descriptors
and phenomena available.

Enter Descriptor and Phenomena
for a second present weather
group, if necessary.

Table 20. Definitions for the Present Weather Manual Observation Panel

Guide to Present Weather Abbreviations

Intensity Descriptor Phenomena
- light BC patches BR mist IC ice crystals
(blank) moderate BL blowing DS dust storm PL ice pellets
- widespread dust well-developed
+ heavy DR low drifting DU PO dust/sand whirls
VC in vicinity FZ freezing DZ drizzle RA rain
funnel cloud,
MI shallow FC tornado, SA sand
waterspout
PR partial FG fog SG snow grains
SH showers FU smoke SN snow
TS thunderstorm GR hail SQ squalls
GS small hail/snow ss sand storm
pellets
HZ haze VA volcanic ash

Adapted from FMH-1 and FAA Order 7900.5B.
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11.9 Visibility Manual Observation
(Keyboard shortcut Alt+m then v)

The Visibility Manual Observation screen (Figure 77) lets you enter a manual observation for
MOR in place of the value generated automatically.

Note: When a visibility manual observation is active, variable visibility will be shown as missing.

When set to Manual, sensor
values must be entered manually
b (= on this screen. Automatically
Manual Obs. - Visibility L_| generated values will be ignored.

When set to Automatic, the values ———— @ Automatic 7 Manual .
) » - Select a value for Meteorological
generated automatically by the Optical Range (in miles) frgm

alOsiwnl bexmed fordspial, MOR: ' '— — the drop-dowon list. Grayed-out

output, and logging. In automatic th=il i AT TGS

mode, the manual observation
entry fields are grayed out. Clear Averages: [ |
OK Cancel
Check to prevent any previously
logged values from being considered
in calculating upcoming averages.
Click to exit and Click to exit and

save entered data  discard entered data

Figure 77. Visibility Manual Observation Screen
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12.

Reports Menu

(Keyboard shortcut Alt+r)

The Reports menu (Figure 78) lets you enter a manual remark to be appended to the METAR.

Reports
METAR Remark ...

Figure 78. Reports Menu

12.1 Entering a METAR Remark

(Keyboard shortcut Alt+r then k)

Manual remarks can be appended to the METAR message using the METAR Remark option on
the Reports menu.

1.

Click METAR Remark on the Reports menu. The screen shown in Figure 79 will
appear.

METAR Remark

Persistent: [ |
Remark: | ]

| OK H Cancel l

Figure 79. METAR Remark Screen

2. Enter the text to be appended to the METAR report in the Remark field. The maximum

number of characters is 80.

Click Persistent to have the remark repeat in each METAR until the Persistent check-
box is unchecked. When the Persistent checkbox is unchecked, the remark expires at the
top of the hour.

115



REPORTS MENU AWOS 3000 USER'S MANUAL

4. Click OK to activate the remark and return to the main display. The remark will appear
in the Remark field at the bottom of the Tower Display, and will be output with the
METAR report.

5. Click Cancel to exit the METAR Remark window without appending a remark. Any new
text entered in the Remark field will be deleted.
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13. System Status Menu

(Keyboard shortcut Alt+s)

The System Status menu (Figure 80) allows you to view active and past alarms, and to turn on or
off the blinking alarm alert.

System Status

Alarms ...

¥ Blink Alarm

Figure 80. The System Status Menu

13.1 Alarms...

Clicking the Alarms... option on the System Status menu calls up a list of current and past alarms,
such as that shown in Figure 81. Each alarm entry in the list shows the date and time of the alarm,
its status (New or Acknowledged), the type of alarm, and a brief description of the nature of the
alarm. The time shown for the alarm is the time when the alarm condition was first met. The time
is not updated when the alarm condition is met again. You can acknowledge or delete active
alarms from the Alarms list.

Alarms
Date | status | Type | Message
19/03/2009 23:25 iNew \Error |DCP - low response rate - check con...
Acknowledge | 1 Delete Close

Figure 81. Alarms List
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13.1.1 Acknowledging and Deleting Alarms

When an alarm is triggered, it will remain active (its status will show New) until either
acknowledged or deleted by the user. No further entries for an active alarm will be added to the
alarm list until it is acknowledged or deleted.

To acknowledge an alarm, click the alarm on the list to highlight it. Multiple alarms
can be highlighted and acknowledged as a group by performing a <Ctrl>-click on
subsequent alarms to select once the first alarm to be acknowledged has been
selected and highlighted. Then click the Acknowledge button at the bottom of the
screen to acknowledge the selected alarms.

"Ack" will be displayed in the Status column on the Alarms list

The color of the Alarm text will change to a lighter red once all alarms have been
acknowledged or deleted. The Alarm warning will continue to be displayed after
the alarm is acknowledged (in the lighter color) even when alarm conditions no
longer exist in order to keep an operator alert to intermittent problems.

To delete an alarm, click the alarm on the list to highlight it. Multiple alarms can be
highlighted and deleted as a group by performing a <Ctrl>-click on subsequent
alarms to select once the first alarm to be deleted has been selected and highlighted.
Then click the Delete button at the bottom of the screen to delete the selected
alarms.

All visual warnings will stop and the Alarm notice on the main display will be
removed

The alarm will be deleted from the Alarms list; a record of the alarm will still be
maintained in the Alarms Log

If the conditions that triggered the alarm are not addressed before the alarm is
deleted, the alarm will reappear

Click Close to close the Alarms list.

13.2 Blink Alarm

The Blink Alarm option controls the alarm's visual appearance on the display. If the box is
checked, the Alarm notice on the main display will blink when active. If the box is unchecked,
the Alarm notice on the main display will remain steadily on. Regardless of the setting, all
alarms will appear on the Alarms list explained above.
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14. Help Menu
(Keyboard shortcut Alt+h)

The Help menu (Figure 82) lets you view the current version of the AWOS 3000 software.

Help |
About ‘

Figure 82. The Help Menu

14.1 About
(Keyboard shortcut Alt+h then a)

Click the About option on the Help menu to view the installed version of the AWOS 3000
software.

The license agreement can also be accessed from this display.
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15. Maintenance

Maintenance of the AWOS is divided into monthly, triannual, and annual mainte-
nance tasks. Detailed sensor and system maintenance instructions are provided in the
AWOS 3000 Maintenance Manual (3000-027).
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16. Remote Maintenance Monitoring (RMM)

The CDP can be accessed remotely from another computer to set system parameters or view
system status and data. This feature is referred to as Remote Maintenance Monitoring, or
“RMM?”. No special software is required to access the AWOS CDP. Any terminal emulator
program, such as ProComm or the Microsoft Windows Terminal Emulator program, can be used
to access the AWOS for RMM.

The CDP is accessed for RMM purposed through the voice telephone line. The voice modem
will switch to data mode if it detects three “*” tones during the call. Once communication is
established, the user can enter commands to perform the following tasks.

¢ End the RMM session

e Enter a password to allow access to restricted functions
e Get a current AWOS system status report

e Get the current AWOS reported weather observation

e Get the AWOS system configuration

e Open a data file for downloading

e Download a data file that has been opened

e Get or set the AWOS system time

e Get or set the AWOS system date

e Get or set sensor online/offline state

e Get or set the VHF voice radio or phone online/offline state
e Reboot the CDP
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16.1 Hardware Requirements

The following are minimum requirements to call the AWOS for RMM.

Terminal emulator program such as Procomm or the Windows Terminal Emulator
(terminal emulator programs are included with most operating systems)

Telephone modem
Dial up telephone line capable of 28.8 or higher data transmission

16.2 Establishing Communication with the AWOS

The following steps are required to access the AWOS CDP via RMM:

1.

2.

Boot the computer to be used to access the AWOS.

Start the computer’s terminal emulator program (Procomm, Kermit, MS Terminal
Emulator, etc.).

Configure the terminal emulator to communicate with the modem (set the comm port,
baud rate, etc.). The recommended settings are 115200 bps, no parity, one stop bit. Other
settings may be required, depending on the modem used. Consult the modem user’s
manual for details.

Type “AT” followed by return and verify that the modem returns “OK.”

Set the duration of the “,” delay to 1 second by typing “ATS8=1" followed by return. The
modem should respond with “OK”.

Dial the phone number by entering the following command:
ATDT <number> ******x*x<cr>

In the above example, <number> is the AWOS voice telephone number with all required

digits (to get an outside line, access long distance, dial the area code, dial the number). The
command is followed by a carriage return. If the AWOS takes some time to connect, insert more
delays in the command string by adding commas.

7.

Once the AWOS recognizes the “*” tones, it will take approximately 15 seconds to
connect to the calling modem. Do not type on the keyboard while the connection
processing is taking place or the connection may be lost. After the modems have
connected, a line of text containing the date, time, site ID, and the message CONNECT
will be sent. You can then use the commands in the next section to obtain status and data.
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16.3 AWOS RMM Commands

Table 21 describes the RMM commands available, along with their corresponding responses.
The valid field entries for commands that use an accompanying variable (such as “filename” or
“sensor”) are listed in individual sections following Table 21.

Each command begins with a “$” character and ends with a carriage return. The commands are
entered through the keyboard. Some terminal emulator programs allow macro keys to be
programmed. The commands may be programmed as macro keys if desired. Refer to your

terminal emulator’s user manual for information on macro keys.

Table 21. RMM Command Summary

RMM Command Description Response
SHANGUP End the RMM session “GOOD BYE” is sent to the RMM computer
and the connection is terminated
Display the current AWOS , .
$GETCUR weather report (formatted as Cl.Jrrent‘one-mmute data (same as line
the system printer output) printer) is sent to the RMM computer
$GETSTA Display the current AWOS Current system status report is sent to the
system status report RMM computer
$CONFIG Display the AWOS system Returns the system configuration data on the
configuration RMM computer

$OPENFIL filename

Open a file for transmission

Filename OPENED OK, or an error message
is displayed

Retrieve the contents of an

Sends the contents of file “filename” to the

$GETFIL .
open data file RMM computer followed by >>END OF FILE
$SETIME Retrieve the AWOS system Displays the current AWOS time on the RMM
time computer
The AWOS sends, “The time will be set to
HH:MM:SS” to the RMM computer. The user
Set the AWOS clock to will be asked to confirm the change by typing
$SETIME hh:mm:ss hh:mmss “$SETIME” followed by return. The AWOS wil
set the time following this user confirmation,
and will respond with “The current time is
HH:MM:SS”
$SETDAT Retrieve the AWOS system Displays the current AWOS date on the RMM
date

computer
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RMM Command Description Response
The AWOS sends, “The date will be set to
MMM DD, YYYY” to the RMM computer. The
user will be asked to confirm the change by
typing “SSETDAT” followed by return. The
AWOS will respond with “The current date is
SSETDAT mmiddlyyyy fﬂ?;}gj@vyvfs systemdate 1o |\ pp, YYYY?
Note: If the date is changed to an earlier date,
resulting in duplicate logs being created for
the same date and time, the newly generated
data will be appended to the existing log file.
No data will be overwritten.
Show display sensor online The AWOS responds with “Offline: (list of
$ONLINE , .
status offline sensors)” or “All sensors are online”
$ONLINE sensor Set sensor "sensor name” o | The AWOS responds with “Offline: (list of
be online offline sensors)” or “All sensors are online”
Show display sensor offline The AWOS responds with “Offline: (list of
$OFFLINE , .
status offline sensors)” or “All sensors are online”
SOFFLINE sensor Set sensor "sensor name” o | The AWOS responds with “Offline: (lst of
be offline offline sensors)” or “All sensors are online”
$PASSWD password Enter a passwqrd to enable The AWO"S r?sponds with Paissword
restricted functions accepted” or “Please re-enter
. : The AWOS responds with on/off status of
$VOICE Display voice output status VHF and phone output
Turn service (“VHF” or
, “Phone”) voice output on or The AWOS responds with changed on/off
$VOICE service onfoff off; example: “$VOICE Phone | status of VHF and phone output
off’
$ID Display system IP data The AWOS responds with system IP data
Notification that a system restart has been
$REBOOT Reboot the CDP initiated is given to the RMM user, and is also

shown on the CDP display
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16.4 Password Processing

The SPASSWD command is required to access all functions except SGETCUR, SGETSTA, and
$CONFIG.

16.5 SOPENFIL: Entering Filenames

The AWOS saves status and weather data in two types of files: ERRLOG files and PRINTER
files.

e ERRLOG files contain status information updated every hour.
e PRINTER files contain a copy of AWOS weather data in the same format used in the line

printer output, updated at one-minute intervals.

ERRLOG and PRINTER files are maintained for the length of time specified on the Edit >
Configuration > Misc > General tab. By default, this value is set to 1 year (365 days).
File names for both types of files are of the format MMMDDY'Y where

e MMM is a three-character month (JAN, FEB, MAR, APR, MAY, JUN, JUL, AUG, SEP,
OCT, NOV, DEC)

e DD is a two-digit day (01 through 31)
e YY is a two-digit year (00 through 99)

For example, to retrieve a file for March 1, 2008, the file name would be MARO108.

16.5.1 Retrieving Data Files

ERRLOG files are retrieved by entering the following with the SOPENFIL command.
$OPENFIL ERRLOG\filename
PRINTER files (weather archive data files) are retrieved by entering the following with the
$OPENFIL command.
$OPENFIL PRINTER\filename
After the open command has been processed, the AWOS will respond with an acknowledgement

of the file open command. An error message may be generated if the file was not opened properly.

Once the file has been opened, the SGETFIL command can be used to retrieve the data. If the
terminal emulator program supports data logging, enable this feature to capture the screen data as
it is downloaded. ERRLOG files may take a few seconds to download; PRINTER files may take
up to one minute to download (depending on the modem connection baud rate).
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After the files have been downloaded, they can be viewed with the terminal emulator program (if
it supports file viewing), or with a text editor or word processor; they can also be printed to your
system printer.

It is not necessary to close a file. The user can simply enter another command or disconnect from
RMM. Data will continue to be logged.

16.6 SONLINE and SOFFLINE: Specifying Sensor Names

The following abbreviations are valid for AWOS sensors/devices.

WS  wind speed

WD  wind direction

TP temperature

DP  dew point

BP barometric pressure

PC  precipitation

VI visibility

CH  cloud height

PW  present weather

ZR  freezing rain

LX  lightning

VH  VHF radio voice; (with “$VOICE service on/off” command, “VHF” is used
instead)

GP  GPS

Sensors that are set offline will not have their data reported in the voice message, and will not
appear on the display terminal, printer, or in archive data. Turning off the VHF radio will cause
voice output to the radio to stop—the radio remains powered on and keyed. The telephone voice
will continue reporting—if all the sensors are offline, the AWOS will report temporarily
inoperative to the voice output.

16.7 RMM Command Processing and Command Responses

Table 21 lists the AWOS responses to RMM commands.

If a command is valid, a response will be generated. If a command is invalid, an error message
will be sent. The system will hang up if three invalid commands in a row are received.

If a password is required to access a function, and a password has not been entered, the AWOS
will not respond to the command even though it appears to have been typed correctly.
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16.8 Terminating the RMM Session

Use the SHANGUP command to terminate the AWOS RMM session. If this command is not
used, the telephone may be busy for up to ten minutes before the AWOS automatically
terminates the call for inactivity.

16.8.1 Automatic Termination

The RMM session will be automatically terminated after a given period of inactivity.
o IfSPASSWD has been entered during the call, the AWOS will hang up ten minutes after
the last command is entered.

e If SPASSWD has not been entered during the call, the AWOS will hang up within two
minutes after the last command is entered.
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Appendix A. DCP Message Format

The format of the input data message from the Model 1190 DCP received in response to a poll
(RDCPO0\r\n) is shown below. An explanation of the data field is given in Table 22.

[Communications: 9600 Baud, No Parity, 8 Data Bits, 1 Stop Bit]
Polled at 5-second intervals.

Preface:
12 {fs
3 syn’s (0x16)

Packet:
1-5 7A000
6 Ascii address (from address dip switch + 0x30)
7-18 000000000000
19-  Data (see Table 22)
cre 4 hex-Ascii crc characters of DATA from 7A000 to the end of the DATA field
cr
cr

If
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Table 22
DCP Data Field Format
Position | Contents Length | Description Range
0-1 Seconds 2 chars 00 to 59
2 blank
3-5 Wind Speed 3 chars 5 sec avg wind speed 000 to 250 or MMM
6 blank
7-9 Wind Dir 3 chars 5 sec avg wind dir 000 to 360 or MMM
10 blank
11-14 Temperature 4 chars 5 sec avg temp 10s degF -400 to 1350 or MMMM
15 blank
16-19 Dew Point 4 chars 5 sec avg dptp 10s degF -400 to 1350 or MMMM
20 blank
21-25 Pressure #1 5 chars inHg*1000 17000 to 34000 or MMMMM
26 blank
27-31 Pressure #2 5 chars inHg*1000 17000 to 34000 or MMMMM
32 blank
33-34 Precip Ctr 2 chars tips (reset at startup) 00 to 99
35 blank
36-38 Cloud Ht 3 chars cloud ht/100ft 000 to 125 or MMM
39 Ceilometer Data | 1 char Bit 0 =1 if clear
Flag Bit 1 toggles every new output | 0, 5,,0r 7
Bit 2 = 1 for 8339 (0, 1, or 3 for 8329)
Bit 2 = 0 for 8329
40 blank
41-45 Visibility 5 chars extinction coeff *1000 00000 to 99999 or MMMMM
46 Visibility Status 1 char counts from 0 to 7 (x30 to x37)
47 blank
48 Day / Night 1 char Day/Night D,N,orM
49 1 char 0
50-53 SIP Status 4 chars SIP Status 4 hex Ascii characters
Bit 1 =(0002) 1 if -5 V DC reference error
Bit 2 = (0004) 1 if +5 VV DC reference error
Bit 3 = (0008) 1 if BP sensor temp lo
Bit4 = (0010) 1 if BP sensor temp hi >+55C)
Bit 5 = (0020) 1 if MARS Fan Failure
Bit 6 = (0040) 1 if Startup in last minute
Bit 7 = (0080) 1 if On Battery Power
Bit 9 = (0200) 1 if No comm, Visibility sensor
Bit A = (0400) 1 if No comm, Ceilometer
Bit B = (0800) 1 if Maint Sw prsd in last 5 min
Bit C =(1000) 1 if No comm, Present Weather sensor
Bit D = (2000) 1 if No comm, BP sensor
54-57 8329 Status 4 chars 8329 Ceilometer Status 4 hex Ascii characters from
8329
58-65 VIS Status 8 chars Visib Stat 8 hex Ascii characters from
Visibility Sensor
66-69 RH 4 chars 5 sec avg RH *10 0000 to 1000 or MMMM
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Table 22
DCP Data Field Format
Position | Contents Length | Description Range
70 blank
71-75 Aux Voltage 5 chars 5 sec avg AuxPort V 0.000 to 9.999 or MMMMM
76 blank
77-89 PresentWx 13 chars | Present Weather Msg WwwPppppSssss or
WMMPMMMMSMMMM
90 blank
91 blank
92-96 ALS VIS #1 5 chars ALS 8364-E in Cd 00000 to 99999 or MMMMM
97-98 BP Temp 2 chars BP Temp °C 00 to 99 (bp temp + 40°C)
99 blank
100-104 LTX 5 chars Lightning sensor data
First character:
0 = no lightning
1 = lightning at the airport
2 = lightning in vicinity
Second and third characters: | decimal range 00-54
sensor status
Fourth and fifth characters: hex range 00-FF.
distant lightning.
105 blank
106-110 FreezingRain Freq | 5 chars Freezing rain frequency Up to 40 kHz
111 blank
112-113 FreezingRain Stat | 2 chars Freezing rain status 2 char status report, one
character for status, one
character for status descriptor
114 blank
115-120 8339 Status 6 chars 8339 Ceilometer Status 6 hex Ascii characters from
8339
121 blank
122-126 Software Version | 5 chars Software Version 5 character free form
127 blank
128-131 CRC 4 chars CRC 4 hex characters
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Appendix B. Drawings

The following pages contain supplemental installation drawings and wiring diagrams.

3000-019 AWOS 3000 CDP Wiring Diagram (Rev B) 1792 VHF
3000-019 AWOS 3000 CDP Wiring Diagram (Rev F) 1793 VHF
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